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 Introduction

Welcome
Thank you for choosing WPI DataTrax2 Data Recording and Analysis Software. Developed 

over a 5-year period, DataTrax2 software is the result of more than 70 man years of collective 
experience in data recording. We are confident that this software will make your data recording 
and analysis easier, and welcome suggestions for improving our products. Please contact us 
with comments, concerns or suggestions at 800-234-1757 or via email at: support@wpiinc.com. 

How to Use This User’s Guide
This User’s Guide assumes you know how to operate your computer and are familiar with 

basic Windows terminology. The Table of Contents lists each chapter and its contents. You can 
use it or the index to locate pages on a particular subject. The Appendix provides some useful 
reference materials.

We have divided the subject matter into categories and explained each in detail, but if you’d 
rather cut to the chase, the Quick Start chapter should have you recording data in less than an 
hour.

System Requirements
DataTrax2 recording software requires a Pentium II-level computer running Windows 98, 

Windows ME, Windows 2000, Windows XP, Windows Vista or a Apple computer running OSX 
10.3 or later, with at least 256 megabytes of RAM and at least 50 megabytes of free space on 
your hard drive. 

The preferred processor is a Pentium III or Pentium 4 with AGP graphics card, 512 megabytes 
of RAM running Windows 98/Me or Windows 2000/XP. The minimum recommended system 
configuration is a Pentium II, 300 megahertz computer. The faster the processor, the smoother 
the screen scrolling, however, all data is recorded regardless of the screen scrolling display.

Installation

From CD DataTrax2 software is provided on a CDROM. If you don’t have a CD drive, the software 
installer can be downloaded from our FTP area. Point your browser to http:/www.wpiinc.com, 
select Support from the directory, and sign up for the WPI Users’ Area. All installers are 
available at the Users’ Area.

Note: Contact your IT department before installing software. You will need to have administrative 
priviledges. Do not connect your WPI hardware to the computer until AFTER the software installation is 
complete.

To install the software using the CDROM:
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1 Insert the DataTrax2 installation CD. 

2 A welcome screen will appear offering to install Software.

3 Follow the instructions presented by the Install Wizard. The Install Wizard will tell you when the instal-
lation is complete and will restart your computer.

4 Once you have completed the installation process, remove the installation CD from the drive, connect 
and turn on your WPI Hardware.

Note: When your hardware is connected for the first time, Windows will advise you “New Hardware found” 
and proceed to load the driver automatically. If for some reason Windows cannot locate the driver, point the 
Install Wizard to the WPI/DataTrax2/drivers folder in the Program Files folder.

From Users’ 
Area

To install using the downloaded installer from our FTP site:

1 Go the Users’ Area on the wpiinc.com website. Select the proper installer for the Windows operating 
system on your computer. After downloading the DataTrax2 software installer, double click on the 
downloaded file. It is a self extracting archive, which will automatically launch the installer after it 
extracts. (Files are normally stored in the Windows Temp Folder). The installer will then open the 
Install Wizard and walk you through the installation.

2 Go to step three above.

Registration and Updates
Be sure to register on-line at our website at: http://www.wpiinc.com. Registering your software 

ensures that you are notified of updates, new releases, and sent the free upgrades you are 
entitled to for as long as you use the program. Software and .pdf manuals are available from the 
password protected area of our website. Passwords are available to registered users only by 
submitting an email request.

Comments and Suggestions
WPI/CB Sciences understands that user feedback is critical to the improvement of any 

software product. If you have ideas, suggestions or criticisms, please contact us at: 
support@wpiinc.com.

Technical Support
If you cannot find an answer in this User’s Guide, please check the list of FAQ’s (Frequently 

Asked Questions) on our website. If you still cannot find a solution to your problem, technical 
support is available to all registered users at no charge via email, phone, fax or mail. When 
requesting technical support, please follow the steps listed below:

• Write down your question or problem and the actions you took that created the problem.

• Be prepared to duplicate the problem.

• Note any error messages.
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• Note your computer model.

• Note your operating system version.

• Note the amount of RAM (Random Access Memory) in your computer.

• Note your DataTrax2 Software version number.

See the sample customer support form in the appendix of this manual.

Following these steps will enable WPI support staff to quickly and efficiently address your 
issues.
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Chapter 1: Quick Start
Start here if you are already familiar with data recording concepts. This chapter contains all 

you need to know to begin recording data quickly and easily.

Managing Signals
The management of recorded data is divided into three steps:

1 Recording data onto the computer,

2 Navigating the recorded data to find particular areas of interest, and

3 Outputting the data either in printed or analyzed form.

Recording 
Data

Recording data is the most basic of the three steps. It is also the only one that is time critical. 
That is, you must record data when it happens, whereas navigating, analyzing or printing data 
can occur anytime after the data has been recorded. The following section explains the basic 
concepts and controls required to record data using the DataTrax2 software.

Start Recording The most basic control in the DataTrax2 software is the one that starts and stops the 
recording. This control is found in the upper right hand corner of the Main window. After 
ensuring that the source of your signal is properly connected to your data acquisition device, 
click the Record button to begin recording. While data is being recorded the Record button will 
change to a Stop button. Click Stop at any time to end data recording.

Displaying Data The events you want to record using the DataTrax2 software may be very slow, like the 
discharge curve of a 9-Volt battery, which can take hours; or very fast, like the QRS complex in 
a human electrocardiogram, which may take only a fraction of a second. DataTrax2 software 
allows you to record both slow and fast events, while displaying the recorded results in a format 
that is easily interpreted. To manage the temporal display of your data in the DataTrax2 
software, a parameter called display time is used. 

1 Display time is simply the amount of time represented by one full screen of data that you see on the 
monitor. When the program opens, the default display time is set to 10 seconds. You can change the 
display time by using the Half Display Time, Zoom Between Cursors or Double Display Time 
controls in the toolbar (Figure 1-1 on page 5).

 Figure 1-1: The Display Time icons on the DataTrax2 Main window toolbar.

• Clicking the Half Display Time button (big mountain) “halves” the screen time. So, a 10-second, full-
screen display becomes a five-second, full-screen display, effectively doubling the display resolution. 

• Clicking the Zoom Between Cursors button fills the display window with the data located between the 
cursors.
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• Clicking the Double Display Time button (little mountain) doubles the screen time. Therefore, a 10-
second, full-screen display becomes a 20-second, full-screen display allowing twice as much data to be 
displayed on one screen.

2 To manage the vertical display of the data on the y-axis of the window, the DataTrax2 software uses an 
AutoScale feature. The AutoScale function examines the recorded data in the current screen and 
adjusts the display so that the data is centered along the y-axis, and the amplitude is adjusted to allow 
the best possible view of all of the data.The AutoScale button is located on the channel bar of each 
data channel. 

• Clicking the AutoScale button resizes the data and centers it on the current screen. The AutoScale 
button can be used as frequently as needed. 

Note: Clicking the AutoScale button, when large artifact spikes are present on the screen, will result in a 
smaller than optimal display of real data since the AutoScale function sets the highest and lowest data 
points close to the upper and lower limits of the screen.

• Two additional controls, a Zoom In button and Zoom Out button, are positioned on either side of the 
AutoScale button. Zoom In expands the channel data and Zoom Out reduces its size.

• Further, the position of the waveform on the screen can be adjusted by clicking on it and dragging it up or 
down.

3 The Value Display box also appears on the channel bar above the channel window. The amplitude 
value of the data at the position of the cursor or the value of the data point that is currently being 
recorded is displayed in the box, in the units you specified. If you are using 2 Cursor Mode, the 
difference between the amplitudes at Cursor 1 and Cursor 2 will be displayed. 

4 Clicking and dragging on the channel bar allows movement of the channel bar up and down, Moving the 
channel bar changes the size of the channel window and the amount of space allocated to the adjacent 
channels.

 Figure 1-2: The common controls of each channel in the DataTrax2 Main window.

Controls The main controls for the DataTrax2 program are located in the Preferences dialog window in 
the Edit menu. Controls are also found in the channel menu of each channel. 

The Preferences 
Dialog Pages

From the Preferences dialog pages, parameters controlling the Channels, Stimulator(s), 
Views, Output Sequences, and Options and Events, can be set. For example, the number of 
channels to be displayed in the Main window and their titles, the sampling rate, and the display 
width of the screen can be set from this dialog window. Many more parameters, some explained 
in other sections of this manual, can be set from the Preferences pages. These parameters can 
also be saved as a settings file, to be used again and again to perform the same experiment. 
The creation of groups of settings and the actual settings themselves is accomplished through 
the functions of the Settings menu.
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Channel Mode Clicking on Channel Mode in Raw Data displays the input option available for a given 
channel. On a computed channel, clicking on Channel Mode allows you to set up an existing 
function or to change and set up a new function on that channel.

The Channel 
Menu

From the channel menu, some of the parameters also controlled in the Preferences dialog 
pages, can be set. These include Units, Scale and Title. 

Add Function Raw data can be transformed by computed functions and displayed as values which provide a 
a clearer interpretation of the data. For example, periodic data, like that of an ECG, can be 
transformed by the Rate function to a plot of the subject’s heart rate (BPM). Some of the 
functions available include: Frequency, Period, Integral, Derivative, Channel Math, 
Spirometry Volumes, and EEG Power Spectrum. Clicking on a Raw Data Channel’s Add 
Function button displays a menu of available functions. Selecting one creates a new channel to 
display the function data.

Saving Data Data recorded in a file can be saved, closed and opened from any computer at a later time for 
analysis.

To save the recorded data in a file, select Save As in the File menu. Name the file in the file 
name box. Choose a destination on the computer in which to save the file (e.g. the WPI or class 
folder). Click the Save button to save the file as an *.iwxdata file. 

Navigating 
Data

Once recorded, data is “navigated” in a few ways:

Analysis Window An area of the data can be selected for viewing and measuring in the Analysis window. 

1 Use the screen time controls (Half or Double Display Time) to provide a better view of recorded 
events. Click on the Double Display Time button (little mountain in the toolbar, Figure 1-1 on page 5) 
until all of the data is visible in a single screen.

2 Once the data of interest is displayed in the Main Window, click the Analysis Window icon and the data 
is displayed in the Analysis Window.

Marks Marks can also be used to navigate data. A Mark is a text annotation made while recording or 
after recording, that is locked to the data at a certain point in time. 

1 To mark the record while you are recording, use the keyboard to type a message on the Marks line. 
Pressing Return or Enter on the keyboard will enter the text mark on the recording at that time.

2 When reviewing data, you can move directly to a mark from anywhere in the data using the Marks 
window. To open the Marks window, click on the Marks button in the toolbar or select Marks from the 
Window menu of DataTrax2. Select the mark of interest. Click the GoTo button to move directly to the 
area of data that contains the mark. Another way to navigate to a Mark is to click on the down arrow 
next to the Mark button and select the Mark of interest.

3 Marks can be entered after data recording is complete using the Single Cursor button (the button with 
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a single vertical line in Figure 1-1 on page 5). 

4 The text attached to a mark can be seen at the bottom of the screen, just above the timeline. Text marks 
can be dragged and dropped anywhere in the record. For example, a mark may denote that a drug was 
administered at a certain time. Using the mouse, you can click on the text associated with a mark and 
drag it to the channel to which it corresponds.

Scroll Bar Lastly, data can be navigated by using the scroll bar at the bottom of the Main window. Click 
on the right scroll arrow to move to data on the right side of the screen. Click on the left scroll 
arrow to move to data on the left side. Alternatively, clicking and dragging the waveform while 
holding the Ctrl Key down allows you to move the waveform to the left and right.

Getting Data 
Out

Printing Data The most obvious method of exporting data is to print it. The Print command in the DataTrax2 
software prints the window (Main, Analysis, ScopeView, Journal) in the foreground. 

To print the Main window, use the Display Time controls to adjust the amount of data on the 
screen. Pull down the File menu and select Print, which prints only data visible in the window.

Copying and 
Pasting Data

Data can be exported to the Journal or other word processing document using the Cut, Copy 
and Paste commands located in the Edit menu of the program. 

The Copy command always looks at the window in the foreground. For instance, using the 
Copy command, while the Main window is in the foreground, copies the data in the Main 
window to the clipboard (as a picture). Adjusting the screen time affects what data will be 
included in the picture. Copying data is best done from the Analysis window; you have more 
control over which channels and time domain will be displayed and copied.

Exporting Data Select areas of data in the file can be saved for export.

• Select the area of data to be saved and exported using the 2 Cursor mode in the Main window.

• Click the Analysis button in the toolbar to view the selected data in the Analysis window.

• Open the File menu and select Export. A dialog box appears and provides for the naming and formatting 
of the file to be exported from the Analysis window. Files to be exported can be saved as pictures (.bmp - 
bitmap and .png - portable network graphics formats are currently supported), a text file (.txt - ASCII or 
.atf - Axon Text), as a MatLab file (.mat), or a DADiSP file (.dat).

• Complete data files can be saved, from the Main window, as a MatLab file or DADiSP file.

Analysis Apart from the cursor measurements available in the DataTrax2 Main window, analysis occurs 
in two places. Data manipulation, close examination, and a variety of calculations are handled in 
the Analysis window, and wave to wave transforms are available in the Main window. For 
specific information on the analyses that each of these categories can perform, refer to the 
Analysis chapter in this manual. The basics are summarized in this chapter.
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On a given selection of data displayed in the Analysis window, the program can calculate and 
report the selected parameters. These are displayed across the top of each channel in the 
channel bar. By selecting the Send To Journal items in the Tools menu (or right-click menu), 
these values for the selected parameters can be sent to a part of the DataTrax2 program called 
the Journal. From any of the Channel menus (or right-click) you can add data and titles to the 
Journal. Copying of the channel display is accomplished using the Copy Graph option.

Journal The Journal is an internal word processing application capable of accepting calculated 
numbers from the Analysis, FFT, or XY window, as well as copied graphs from any window. In 
addition to values and pictures, text can be put into the Journal using the keyboard. This allows 
lab reports or explanatory documents to be composed without having to leave the DataTrax2 
program.

Calculations In the Analysis window, data can be reduced using mathematical operators like mean or 
maximum. These operators generally take a selection of data, operate on it and produce a 
single number as a result.

A second and quite different type of analysis requires that an entire set of data be trans-
formed, point for point, into a completely different, but related set of data. Transforming data 
into its first derivative is a good example of this type of analysis. DataTrax2 software includes 
several of these Wave-to-Wave transforms in the Add Function menu of each channel. 

The list of available functions is always expanding. DataTrax2 V2.0 includes: Periodic 
Functions, Integrals, Derivatives, Channel Math, Filter, Smoothing, Power, Spirometry, 
Cardiac, EEG, Multipoint Calibration and Gain Telegraph.

These calculations are also available in the Function list on the Channel Page of the Prefer-
ences dialog window. Functions typically used on signals recorded in a biology lab are listed. 
Functions can be changed and these modifications can be saved in new settings files stored in 
the Settings Groups.
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Chapter 2: Acquisition

The Basics 

Time, 
Temporal 
Resolution, 
Sample 
Speed, and 
Aliasing 

Temporal resolution in digitally recorded data is determined by the sampling rate, also known as 
sampling speed. To select a suitable sampling rate, you will need some background on the 
theory and use of analog-to-digital converters (ADC). 

The ADC in the WPI computer interface takes simple voltage measurements at regular 
intervals. The voltage measurements (Y-axis values) and the times at which the voltages were 
recorded (X-axis values) are sent by the WPI interface to the DataTrax2 software as a pair of 
(X,Y) coordinates. The DataTrax2 software displays these coordinates as data points by plotting 
them. The software then connects the data points with a line to create the smooth, graphical 
appearance of an analog chart recording; but, only the data points themselves are hard 
measurements. The lines that are drawn to connect the data points are “educated guesses” 
made by the software and may be misleading. For example, if the sampling speed being used is 
not fast enough for the data being recorded, the display will not accurately represent the real 
data. This misleading behavior of data acquisition software, can be avoided by using a sampling 
speed that is fast enough for the data being recorded.

When the sampling speed is set in DataTrax2 software, the hardware is being told what the 
time interval between samples will be. For example, 100 samples per second equals one sample 
every 10 milliseconds. To avoid creating displays that may be misleading, a simple question 
about the sampling interval needs to be asked: Is there a chance that something important has 
occurred between the sample points?

If the answer is “yes,” then the sampling speed must be increased in order to see and record 
that event. In the example presented in Figure 2-1 on page 10, a sine wave with a frequency of 
100Hz is sent to the ADC. In the screen on the left, the data points, recorded by an ADC set to 
the same sampling speed as the frequency of the sine wave, are marked.

 Figure 2-1: A 100Hz sine wave recorded at 100Hz. The samples coincide with the peaks of 
waves; so, the data points can be connected by a straight line.

Because the sine wave has the same frequency as the sampling rate, each recorded data 
point occurs at the same place in each cycle of the sine wave. In the screen on the right, a 
straight line is the result when the data points are connected. The line is a false representation 
of the real data, which is a sine wave. To fix the problem and render a better picture of the data, 
a faster sampling rate is required. If the sampling rate is increased to 110 samples a second, the 
data points would be a millisecond closer to each other than at 100 samples a second, but a 
100Hz sine wave would still have only one data point for each cycle. When the data points are 
2 Acquisition 10



connected by a line, a sine wave with a frequency of 0.1Hz is displayed on the screen. Again, 
the wave displayed on the screen is not a true representation of the real wave because the 
sampling speed is too slow. 

So, how fast does the sampling speed need to be to record a reasonable representation of a 
real waveform? A general rule of thumb is to sample at a rate that is a minimum of five times 
faster than the fastest frequency of interest in the waveform. 

To determine the optimal sampling frequency, find the shortest event in a sample recording. 
For example, the R wave has the shortest duration of any event in the ECG and should be used 
to determine the sampling speed needed to record a reasonable representation of the ECG. 
Next, find the rise time (in seconds) of the R wave. The rise time is the time it takes the wave of 
interest to go from its start to about 2/3 of full value. In the case of the R wave in an ECG, this 
value is about 20 milliseconds (0.020 seconds). 

Substitute the value 0.02 for the rise time in the following equation to determine the bandwidth 
of the event (R wave): 

0.159/Rise Time = Bandwidth

0.159/0.020 = 8

Finally, multiply the bandwidth by five to determine the minimum sampling frequency needed, 
which is 40Hz in this example. Higher sampling rates give better pictures, at the expense of 
making data files larger. Therefore, choosing a proper sampling speed must be a balance 
between the accurate portrayal of the data and the unwieldy size of the data file.

The default sampling speed set in the DataTrax2 software is 200 samples per second. This is 
adequate to execute most of the laboratory experiments presented in the laboratory manuals 
furnished with the WPI teaching kits.

If sampling speeds are set manually, it is always best to 
start sampling the data at the fastest speed possible. 
Then, slowly reduce the sampling rate to a speed where 
data initially begins to degrade. Finally, set the sampling 
speed just above the rate that initially cause degra-
dation. See the examples of pulse waves sampled at 
different frequencies in the appendix.

Sampling rates are set from the Speed menu on the 
Channels page of the Preferences dialog window. The 
Preferences dialog window is called by selecting Prefer-
ences from the Edit menu.

The speeds displayed in the Speed menu are rates per 
second per channel. This menu is dynamic, the maximum 
available sampling speed will adjust depending on how 

many channels are open.

Make sure the Display Time, as programmed on the Channels page of the Preferences 
dialog window, is set to 10 seconds before doing the following exercise.

Exercise 1 Plug the DIN connector on the cable of the pulse transducer (PT-104) furnished with your kit into 
Channel 3 on the WPI/214 interface. Wrap the plethysmograph (pulse transducer) firmly around the end 
of the subject’s middle finger.
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2 Open the Channels page in the Preferences dialog window and set the sampling speed to 1,000 
samples per second. Record 10 seconds of data.

3 Next, set the sampling speed to 500 samples/second and record an additional 10 seconds of data.

4 Repeat this procedure for sampling speeds of 200, 100, 50, 20 and 10 samples/second. 

Display a section of each recording block in the Main window, then switch to the Analysis 
window. Closely examine the recorded data as displayed in the Analysis window. Notice that 
the signal becomes progressively more coarse as the sampling rates go down, until eventually 
the signal is unrecognizable.

Vertical 
Resolution

As stated earlier in this chapter, the ADC takes measurements at regular time intervals to 
produce data points with X,Y coordinates and the DataTrax2 software later plots and connects 
the data points with lines. 

The temporal resolution of the incoming signal was the topic of the previous section of this 
chapter. In this section, the vertical (voltage) or amplitude resolution of the signal will be 
discussed.

When making a measurement of length with a ruler, the accuracy of the measurement is deter-
mined by how many gradations are printed on the ruler. Clearly, a ruler with gradations every 
eighth of an inch is more precise than a ruler with a gradation every inch. The more lines or 
gradations there are per unit of measure, the more accurate the ruler. 

If the ADC is considered to be a ruler for voltage, then its resolution (its number of gradations) 
is determined by a parameter called “bit depth.” 

In an 8-bit word, or byte, there are 256 (28) different possibilities for the value of the byte. A 9-
bit word has twice that many possibilities (512), a 10-bit word has four times as many (1024) 
and so on. LabTrax 4/16 and the WPI 118 use a 16-bit ADC providing 65,536 different possibil-
ities, while the  LabTrax 24 series uses a 24-bit ADC providing for 16,777,216 possibilities. The 
Digital Resolution of the ADC is the range divided by the number of possible ADC steps. This is 
the minumum measurement possible with the ADC.

It is important to realize that it is not possible to make a measurement with more precision 
than the Digital Resolution unless the bit depth is increased or the input range is narrowed. 
Changing the bit depth requires a different ADC to be placed in the unit. However, the input 
range can be easily narrowed by applying amplification (gain) to the signal before the signal is 
presented to the ADC. If a 1000X gain is applied to the incoming signal by an amplifier, the 
minimum resolution of the ADC improves

Note: The actual resolution of the system depends on both the analog and the digital resolution. It is 
important to always consider the resolution of the sytem as a whole. 

Signal Conditioning

Gain As pointed out in the section on vertical resolution, there is a minimum voltage beneath which 
the ADC cannot read. This voltage ±304µV for the WPI 118, LabTrax 4/16 and ±1.2nV for the 
Labtrax 24 series. If the signal being measured is very small, additional gain can be applied to 
the signal before it is presented to the ADC by using a bioamplifier.
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For example, consider an ECG, whose total peak to peak amplitude is only 2 mV. The number 
of steps that can be resolved with an 16 bit ADC is 2mV/0.600uV or a little more than three 
steps, which is not sensitive enough to see any meaningful changes. If an amplifier is placed 
between the signal and the analog to digital converter (ADC), the “raw” signal can be amplified 
by a selected gain. For example, if the gain is 100 times (X100), the 2mV ECG signal becomes 
a 200mV signal. Now, when the amplified signal is presented to the ADC, it is 100 times bigger. 
The minimum signal now would represent only 1/658th of the total signal (304µV/200mV). It can 
be seen that a 16-bit ADC is much more tolerant of small signals, making the gain required to 
view a small signal with a 16-bit unit less critical.

Adding gain to the recording system improves the signal to noise ratio of the measuring 
system, but the cost is that the ADC cannot see any signal above the +10V or below the -10V 
input limits. In the case where X100 gain is applied to a 0.2V signal, the amplified signal 
becomes 20V. This is above the +10V input limit of the ADC, so the signal is out of range. In 
fact, the effective input range of WPI ADC units is equal to ±10V/Gain. So, if a gain of X10 is 
used on an amplifier, the effective input range of the ADC drops to ±1V (±10V range/X10 gain). 
Any input signal larger than 1 volts will be out of range. If a gain of X100 is applied to the input 
signal, the effective input range of the ADC is restricted to ±0.1V, and so on.

DIN 8 Inputs The DIN 8 inputs on WPI analog to digital converters can apply up to X1000 gain. This is 
accomplished through the placement of a gain programming resistor within the DIN 8 connector 
of the transducer or cable that can be plugged into the DIN 8 inputs of the WPI units. Gain 
programming resistors are ALREADY PRESENT IN ALL WPI TRANSDUCERS. Gain 
programming resistors can be installed on NON-WPI transducers by rewiring the connector. 
Consult the hardware section in the appendix of this manual for the pin configurations and 
diagrams of the DIN 8 connectors used with WPI ADCs.

Offset Offset is sometimes referred to as “positioning.” Some recorders, amplifiers, and transducers 
have a knob that positions the baseline of the recording on the screen. Positioning control 
permits the centering of the signal which makes measurements more convenient, or the lowering 
of the baseline to accommodate the display of a signal that has more gain applied to it. The 
availability of the AutoScale feature in the DataTrax2 software reduces the need for a 
positioning knob. In fact, the very low noise of the WPI Recorders makes positioning controls 
unnecessary as signals are automatically centered and expanded to fill the recording screen 
when the AutoScale button is clicked. Positioning of the waveform may be accomplished by 
clicking on the waveform and dragging it to the desired position within the channel.

Filters Filters can be set to remove certain frequencies from signals. Hopefully, the frequency infor-
mation removed when the filters are applied is noise and not part of the signal of interest. There 
are two basic types of electronic filters: Low Pass and High Pass. When used in combination 
with each other, these filters can create either Band Pass or Band Reject (Notch) filters.

By definition, Low Pass filters PASS only those frequencies beLOW the set frequency. For 
example: in an electrocardiogram, a large percentage of the ECG signal information is contained 
in frequencies below 40Hz. A significant noise source in such recordings is the 60Hz line 
voltage (110V AC power, or mains) used to power equipment and lights. A 50Hz Low Pass filter 
would allow all frequencies below 50Hz (including most ECG information) to pass to the 
recorder, but would exclude all frequencies above 50Hz, including the 60Hz noise from the 
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mains. The end result of using the 50Hz Low Pass filters is the creation of a quieter, more 
readable ECG. In general, the application of a low pass filter “quiets” the baseline and improves 
the signal to noise ratio of the recording.

On the other hand, High Pass filters PASS frequencies HIGHer than the set frequency. These 
filters can remove low frequency interference, such as baseline drift or a standing offset voltage, 
so that the user sees a more stable baseline.

High Pass, Low Pass and Band Pass filters can also be applied to each channel from the 
Filter function available from the Add Function button on the Channel Bar of each channel. 
These filters are not “Hardware” filters; they are executed in software and work on all ADC units 
running DataTrax2. Unlike hardware filters, software filters can be applied AFTER the data is 
recorded. These filters also work in real time and can be applied to data as it is being recorded.

Averaging In addition to filtering, the DataTrax2 software can apply another quieting technique to data 
recorded at speeds less than 200 samples per second. In the section on temporal resolution, it 
was demonstrated that fast events require fast sampling speeds. What happens if slow events 
are recorded at fast sampling speeds? More information is collected than is needed to 
accurately display the signal. What should be done with the extra data? At sampling speeds of 
100 samples per second or less, the DataTrax2 program operates on the “extra data” using a 
technique similar to the oversampling employed by CD players to reduce noise. The amount of 
oversampling that occurs is determined by the sample speed that you set. The end result is that 
small signals recorded at slow speed will appear less noisy than small signals recorded at high 
speed.

Outboard 
Conditioning

WPI Data Acquisition Systems with built-in amplifiers and filters, can be controlled by the 
DataTrax2 software.These amplifiers and filters should be adequate for most applications. In 
cases where additional or custom signal conditioning is required, outboard devices can be used 
to condition the signal before it is presented to the WPI Data Acquisition System. WPI makes a 
full range of amplifiers for this purpose, but any amplifier with an analog output can be used. 
This allows other amplifiers, like those from Thornton or Grass, or special purpose devices, like 
those made by Warner Instruments, Axon instruments, or World Precision Instruments, to be 
used with WPI Data Acquisition Systems. Outputs from these and other devices can be 
connected to the available BNC inputs on the front panel of WPI Data Acquisition Systems. 
Outputs of external devices can also be connected to the DIN 8 inputs with an adapter cable 
available from WPI.

Chart Mode
Once the signal source is connected to the WPI unit and the signal conditioners are 

configured, data recording can begin. The most basic controls required are the ones that turn 
the recording on and off. DataTrax2 has three ways to Start a recording and two ways to Stop it.

Starting 
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The dialog boxes (Figure 2-2 on page 15) show the options for starting the 
recording process for both groups of hardware.

 Figure 2-2: The DataTrax2 Start dialog boxes

User The easiest away to start the recording is for the User to manually press the Record button in 
the upper right hand corner of the DataTrax2 Main window. User is the default setting in 
DataTrax2. Recording begins when the User presses the Record button, and will continue until 
one of the Stop conditions is met. Pretriggering is not possible in the User (manual) mode.

Timed If desired, the recording of data can be delayed for a user specified fixed duration.

External Trigger Sometimes, it is necessary to synchronize the beginning of the recording with the beginning of 
an external event. The DataTrax2 software can be configured to start recording when the WPI 
hardware detects a voltage pulse (+3 to +5V amplitude) through the BNC connector of the 
Trigger input. Many devices have Trigger or TTL outputs that are capable of starting the 
DataTrax2 recording software; these devices include: stimulators, relays, pumps, valves and 
cameras.

Triggered from 
Channel 

For various reasons, data recording may not need to begin until the data itself reaches certain 
criteria. For example, it may be necessary to record an animal’s body temperature only if the 
base temperature exceeds 100°F. The DataTrax2 software could be programmed to begin 
recording when the data on the temperature channel exceeded 100°F. Thresholds above and 
below a certain data value can be set to start the recording.

Open the Preferences dialog window from the Edit menu. Click on 
the tab for the Channel page. Pull down the Start Mode menu and 
select the channel (Ch) that contains the data to be used as a 
trigger. Set the values that the data must meet before recording is 
triggered. The diagram demonstrates that DataTrax2 is programmed 
to look for a trigger from the data on Channel 1 when the amplitude 

of the data is above 1.5V and below 2 V. 

Pretriggering When an External Trigger or a trigger from a data channel (Ch)is 
used, the data just before the trigger occurs may be important to 
record as well. For example, if the R wave is used to trigger the 
recording of an ECG, the P wave and other parts of the ECG that 
occur before the R wave can be recorded. The Pretrigger feature of 
the DataTrax2 software can be used to look back in time and display 
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a small piece of data prior to the trigger. To enable pretriggering, check the box next to the label 
Pretrigger (in the Start Mode box on the Channel page of the Preferences dialog window). 
Enter the amount of pretrigger time needed in the edit box to the right of the Pretrigger label.

Stopping Once recording begins, the DataTrax2 programs offers two different ways to halt the recording: 
User or Timed

.

 Figure 2-3: The Stop dialog boxes.

User User is the default Stop value for DataTrax2 and can be reset from the Stop Mode box on the 
Channel page in the Preferences dialog window. In User mode, the Stop button in the upper 
right hand corner of the DataTrax2 Main window will stop the recording when clicked. The 
Record button changes to the Stop button after the Record button is clicked to begin the 
recording. The Stop button remains visible until it is clicked. Clicking the Stop button will 
change it back to Record.Timed

When Timed is selected as the stop mode, the DataTrax2 software will stop recording 
automatically after a predetermined time (in seconds), which is entered into the edit box.

Pausing Display It is sometimes desirable to pause the scrolling display of data while at the same time 
continuing to record data. In DataTrax2, this is accomplished by clicking the Pause Display 
button in the lower left hand corner of the Main window.

Scope Mode

When to Use 
the Scope 
Mode

The first devices used to record data were electromechanical. These devices used a stylus or 
very fine pen that was moved by a sensitive motor. The frequency response of these machines 
was very low; the fastest events that they could record were on the order of tenths of a second. 
As science progressed, it became obvious that there were faster things in nature than pen 
recorders could visualize. The oscilloscope or “scope” is able to take a fast, brief snapshot of an 
event, but the continuous chart-like recording is sacrificed. An oscilloscope capturing a fast 
moving electrical signal, like an action potential, is analogous to high speed, stop motion 
photography capturing the movement of a hummingbird’s wing. 

To effectively use the Scope mode in the DataTrax2 program, the length of the snapshot 
(display time) and the sampling rate need to be set to accurately visualize the event. Events that 
are best captured using the Scope mode are brief and repetitive. Action potentials and most 
neurophysiological signals are good examples of signals that are best recorded in Scope mode.

In addition to being able to capture a very brief event in time, a proper trigger is needed to 
begin the recording of the event at the moment it takes place. Using the example of stop motion 
photography, if the high speed camera snapped the picture too soon or too late, the picture may 
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not show the event that was trying to be captured. So the acquisition of data at the right moment 
requires a proper trigger. In the Scope mode either of the previously discussed “non-manual” 
modes, External Trigger or Trigger from Channel, can be used to start the sweep.

Acquiring 
Data in the 
Scope Mode

Scope mode can be enabled from the Channel page in the Preferences dialog window, which 
is accessible under the Edit menu. Data can be acquired on as many channels as are available. 
Data can be viewed in either Chart or Scope format with some limitations. Switching between 
formats is done by changing the acquisition mode in the Channel Page of the Preferences 
window. The limitations to viewing data in the Scope or Chart format are the following: 

• If data is recorded in Scope mode, each sweep or record segment is treated as a block of data. When 
viewed in Chart mode, sweeps (or blocks) are laid end to end, in the order that they were acquired. Data 
can be scrolled.

• If data is recorded in Chart mode, each block or record segment is treated as a sweep. 

Set Up the 
Software

To program DataTrax2 to record in Scope mode, pull down the Edit menu (Application menu 
on Mac) and select Preferences. Open the Channel page of the Preferences dialog window. 
Select the appropriate Scope acquisition mode. The acquisition mode can be set to either 
Repetitive, Multiple or Averaged. Next, set the Start mode that will begin the recording of the 
sweep. The triggers that are available are: User, for manual starting of the sweep that can be 
linked to the output of the ADC; External Trigger, for triggering by an external source; Trigger 
by Channel, for triggering by an input signal, Timed Trigger for delayed start.

 Figure 2-4: The Scope application setup controls.

Repetitive Mode When the Record button is clicked in Repetitive mode, each new sweep overwrites the 
previous sweep. Real oscilloscopes work in this way. When the Stop button is clicked, only the 
last trace is saved.

Multiple Sweep 
Mode

When the Record button is clicked in Multiple Sweep mode, DataTrax2 will acquire and save 
a predetermined number of sweeps. The number of sweeps in a series can be set in the number 
of Sweeps box on the Channel page. The beginning of each recorded sweep is determined by 
the Start mode conditions. A Delay Between Sweeps can also be programmed in the Multiple 
Sweep mode. If zero is selected as the Delay Between Sweeps, the next sweep in the series is 
taken as soon as the software is ready.

Averaged Mode When the Record button is clicked, DataTrax2 will record the user specified number of 
Sweeps, but will only save and display the averaged sweep.
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Sweep Length When operating in Scope mode, DataTrax2 takes “snapshots” of data. Each “snapshot” is 
called a sweep and has a pre-determined length. The sweep length (or Stop Time) is set in the 
Stop Mode section of the Channel page from the Preferences dialog window. By choosing 
Timed as the Stop Mode, the sweep length (in seconds) can be entered into the edit box in that 
section of the page.

Sampling Rate Determining the optimal sampling frequency in Scope mode is the same procedure as used for 
Chart mode. First, find the shortest event in the record. If the compound action potential is used 
as an example, the spike goes from baseline to about 80% of its full amplitude in about 0.35 ms. 
If you substitute.00035s for the rise time in the following equation:

0.159/Rise Time = Bandwidth

0.159/0.00035 = 454

Multiply the bandwidth by five and the minimum sampling frequency is 2270Hz. Doubling the 
sampling rate to 5kHz ensures that the trace recorded is representative of the signal.

If the entire event of interest is only 0.1 seconds long, a sweep at 5,000 samples per second 
occupies only 500 data points. Since the DataTrax2 program can accommodate up to 1,000,000 
points per screen while recording, there is substantial room available for a wider display or a 
greater sampling rate.

Saving Your Data

Every software manual has a section on the importance of backup and saving. DataTrax2 is no 
different. SAVE YOUR DATA! 

Consider that the data acquisition process imposes new and different constraints on the task 
of saving data. A word processor or spreadsheet document can be saved anytime that the user 
thinks about it. The user simply stops writing and saves the document. 

In a data recording application, data is constantly being added, sometimes at fantastic rates 
(200,000 bytes/second at top speed). To save data, the recording would have to be stopped. In 
most recording applications, this is impractical. 

When the recording is stopped DataTrax2 saves the current data to disk. As the DataTrax2 
program acquires data, it buffers the unsaved raw data to a file on the hard disk. In the event of 
an unexpected loss of power or computer crash, the data is preserved. When the DataTrax2 
software is reopened after such an event, DataTrax2 will ask the user if they want to recover the 
data. If the answer is yes, the backup file is recovered and data is preserved. To permanently 
save the data, use the Save As function BEFORE RECORDING ANY NEW DATA. 
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Chapter 3: Display

Introduction
From a functional standpoint, the DataTrax2 program is really two programs. It is primarily a 

data acquisition application, whose main task is to record analog experimental data as data 
points (with X and Y values) and store these data points on the computer. The second task of 
the DataTrax2 program is to graphically display the collected data in a way that is under-
standable to the user. Chapter 2 explains the various controls and options relative to the acqui-
sition of data. This chapter will discuss considerations regarding the display of collected data on 
the various windows in the DataTrax2 user interface.

User 
Interface

The DataTrax2 user interface contains six primary windows; Main, Analysis, XY, FFT, Marks, 
and Journal. There are also dialog windows, accessible through the Preferences selection in 
the Edit menu, which provide controls of the Channel, Stimulator, Views, Sequences and 
Options. Most of the interface related features in DataTrax2 can be found in the Main window 
(Figure 3-1 on page 20). DataTrax2 can display up to 64 channels in the Main window.

 Figure 3-1: The DataTrax2 Main window.
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Each channel has its own set of controls located in a Channel Bar immediately above each 
channel’s data window (Figure 3-2 on page 21). Y-axis scaling is printed to the left of the data. 
The Channel Bar contains the Channel Menu, Channel Title, buttons for Y-axis display control 
(Zoom-In, AutoScale and Zoom-Out), Add Function button and a Value Display area. The 
Value Display box located to the extreme right on the channel bar will display different values 
depending on the state of the program. While recording, the Value Display box shows the value 
of the last data point collected. Off-line, in Single Cursor mode, the Value Display box displays 
the Y-axis value of the data point intersected by the cursor. In 2 Cursor mode, the Value 
Display box displays the difference between the Y-axis values intersected by the two cursors.

 Figure 3-2: The common controls for channels displayed in the DataTrax2 Main window.

Cursors If someone handed you a paint brush, gestured in a general direction, and said: “Paint that!”; 
you would probably want to clarify exactly what “that” was. In mathematical terms, the verb 
“paint” is the function and the object “that” is the argument. In mathematical operations, it is 
important to understand exactly the “that” on which you are operating. 

This is also true for DataTrax2 software. Many commands are included in the program that 
allow the user to zoom, measure and calculate. In order for these commands to work, a 
mechanism is required for directing the software to focus on a range of data or specific data 
points of interest. DataTrax2 uses cursors to identify the data points. The explanation of cursors 
begins with basic modes of operation and how to apply them in the window where the cursors 
are used.

Cursor Modes Cursors are vertical blue lines that pass through all channels. The DataTrax2 software has two 
cursors. Icons in the toolbar allow you to choose between using Single Cursor or 2 Cursor 
modes (Figure 3-3 on page 21). Cursors can also be “garaged,” or placed all the way to the left 
hand side of the data so they measure or report nothing. Cursors in the DataTrax2 software are 
always in one of three modes — garaged, single, or 2 cursor.

 Figure 3-3: Cursor controls on the DataTrax2 Main window toolbar.

To access Single Cursor mode, press the Single Cursor icon (Figure 3-3 on page 21) in the 
toolbar. In this mode, the value of the data point on each channel that is intersected by the 
cursor bar, is reported in the Value Display area on the right side of each channel bar. The time 
3 Display 21



. .
 

for the position of the cursor is reported in the Clock Area in the upper right hand corner of the 
Main window. Single Cursor mode is used to determine values and to place marks in the record 
after recording has stopped. 

To access 2 Cursor mode, press the 2 Cursor icon (Figure 3-3 on page 21) in the toolbar. In 
this mode, the Value Display area reports the difference in value between Cursor 1 and Cursor 
2. In a similar way, the Clock Area reports the difference in time between the two cursors. When 
using 2 Cursor mode, the cursor farthest to the left is always Cursor 1 and the other to the right 
is always Cursor 2. 2 Cursor mode is also used to define the right and left boundaries of a 
selection of data. This selected area can be used to determine what two values are used to 
accomplish the Units Conversion function.

Moving Cursors Once cursors have been called, they may be moved by placing the mouse over the cursor bar, 
clicking, holding and dragging them to the right or left. Cursors may also be moved using the 
arrow keys on the keyboard. In 2 Cursor mode, you can change the cursor that is moved by 
using the UP arrow. Pressing the RIGHT or LEFT arrow key on the keyboard, moves the cursor 
one data point. Holding the SHIFT key down while using the arrow key causes the cursor to 
move five data points at a time; and holding the CONTROL key down while pressing the RIGHT 
or LEFT arrow moves the cursor forward 10 points at a time.

Behavior of 
Cursors

In Single Cursor mode, the value displayed represents the value identified on the channel by 
the one and only cursor. If the data is scrolled so that the cursor goes off screen, the cursor is 
automatically garaged and the channel display area will display the value of the visible data 
point furthest to the right.

In 2 Cursor mode, Cursor 1 is always the left hand cursor. If Cursor 2 is moved to the left of 
Cursor 1, it becomes Cursor 1. Values reported in the Value Display area are always the 
difference between Cursor 2 and Cursor 1 (Cursor 2 minus Cursor 1). If the data is scrolled, so 
that one of the cursors is no longer on the screen, that cursor is automatically garaged and the 
display goes to Single Cursor mode.

Exercise Load the data file Cursor_Exercise.iwxdata in the Program Files->WPI->DataTrax22->tutorial 
files folder, by selecting the Open item in the File menu. The data displayed on Channel 1 is a 
±2V sine wave. Note that the Value in the Value Display area corresponds to the voltage of the 
last data point (farthest to the right) in the window.

• Select Single Cursor mode by pressing the Single Cursor icon in the toolbar (Figure 3-3 on page 21). 

• Record the value that corresponds to the position of the cursor. 

• Click, hold and drag the cursor over the highest point in a given cycle of the data. Adjust the position of 
the cursor bar left or right by using the left or right arrow keys on the keyboard. Adjust the position of the 
cursor bar so that the Value in the Value Display area reads +2V.

• Call the 2 Cursor mode by pressing the 2 Cursor icon in the toolbar (Figure 3-3 on page 21).

• Position Cursor 1 so that it is over the maximum value in a given cycle, then position Cursor 2 over the 
minimum value as shown (Figure 3-4 on page 23). The Value reported will be 4V.

• Now, drag Cursor 2 to the minimum value before Cursor 1. When you release Cursor 2, it becomes 
Cursor 1 and the new Value reported is -4V.
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Main Window Display Considerations
Recorded data has two important dimensions: length and height. The length is the Time axis 

and the height is the Amplitude. Each of these has its own set of controls 

Managing 
Display Time

The events recorded using DataTrax2 software may occur over varying time frames. For 
example, recording the discharge curve of a 9-Volt battery could take hours, while recording the 
QRS complex in a human electrocardiogram might take only a fraction of a second. DataTrax2 
software allows the recording of both very slow and very fast events while displaying the 
recorded results in a format that is easily interpreted. To manage the time display in the 
DataTrax2 software, we use a parameter called Display Time. Display Time is the amount of 
time represented by one full screen of data. When the program opens, the default Display Time 
is set to 10 seconds. Display Time can be changed by using the display controls in the toolbar 
(Figure 3-4 on page 23), or by manually entering a Display Time in the place provided at the top 
of the Channel page of the Preferences dialog window, which is launched by selecting Prefer-
ences under the Edit menu.

Clicking the Half Display Time icon (big mountain) halves the screen time. If you clicked this 
icon once, a 10-second full-screen display would become a 5-second, full-screen display. This 
doubles the screen resolution, but cuts the amount of data seen on the screen in half. Clicking 
the Double Display Time icon (little mountain) doubles the screen time. In this case, a 10-
second, full-screen display would become 20-seconds wide. This reduces the screen resolution 
by half, but doubles the amount of data that you see on the screen. Clicking the Zoom Between 
Cursors icon fills the display with the data located between the cursors.

 Figure 3-4: Display Time icons in DataTrax2 Main window toolbar.

Limits Using the Double Display Time control compresses the data. The display time can be 
doubled as many times as requested until the limit of the maximum size of the data file or 
1,000,000 data points is reached. 

Using the Half Display Time tool expands the record as many times as requested. But, the 
DataTrax2 program will not display less than 10 data points on a screen of data.

Double-clicking the Display Time area at the top of the Main window resets the X-axis time 
display to the default value originally entered on the Channel page of the Preferences dialog 
window.

Examples Here are two examples demonstrating the use of the Display Time feature. In the first 
example (Figure 3-5 on page 24), a human electrocardiogram is recorded with a 160-second 
screen time. Notice that the record is compressed and it is impossible to resolve detail in 
individual events. By clicking Half Display Time five times, the screen time is reduced from 160 
seconds to about five seconds, making individual events clearly visible.
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 Figure 3-5: ECG viewed with a long screen time (top) and a short screen time (bottom).

In the second example (Figure 3-6 on page 24), a one hour battery discharge curve is shown 
in two views. The 2-second screen time shows almost a straight line, but clicking Double 
Display Time eight times reveals the entire curve. The Display Time parameter, with its two 
controls, effectively handles the time display.

 Figure 3-6: Voltage drop of 9-Volt battery viewed with short (top) and long (bottom) screen times.
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Managing 
Amplitude 
Display

The vertical display of your signal is managed in a number of ways. In each channel toolbar 
(Figure 3-7 on page 25), there are three icons. They represent the Zoom-In (x2), AutoScale 
and Zoom-Out (x2) features. Clicking and dragging the waveform can be used to offset the 
recorded wave up or down. In addition there is a Scale menu available from either the Channel 
menu or by clicking on the values in the Y-Axis on the left hand side of each channel. There are 
five options available from the Scale menu: Set Scale, Preferred Scale, Zoom In, AutoScale 
and Zoom Out.

 Figure 3-7: The channel toolbar in the DataTrax2 Main window.

AutoScale AutoScale, as used in the DataTrax2 software, reviews the current screen of data on the 
channel of interest and locates the highest and lowest data points in that screen. It then adjusts 
the Y-scale range to include those points. This optimizes the look of the waveform on the screen 
giving you the best possible curve.

Zoom-In/Out From any view of data, pressing the Zoom-In button will double the displayed size of the 
trace. Pressing the Zoom-Out button will reduce the displayed size of the trace by a factor of 
two.

Preferred Scale For any data, there is a basic range within which the Y values of the signal will occur. For 
example, if measuring room temperature, the user might select a range of 50oF to 100oF 
because it is doubtful that the signal will move beyond these limits. If an event of interest occurs 
during the recording, the area of interest can be expanded using the Zoom or AutoScale tools. 
To return to the Preferred Scale set by the user, simply select the Preferred Scale option from 
the Scale Menu.

Set Preferred Scale To set the range of the Preferred Scale, choose the Set Scale option from the Scale menu 
and enter the upper and lower limits of Y-scale in the Set Scale dialog window that appears. 

Scroll Up/Down When the Zoom tools are used, the data may drift above or below the center of the display 
area, or even go out of the range of display. To adjust the position of the trace on a channel, 
click and drag the waveform to the desired position.

Views DataTrax2 can acquire data on up to eight channels on the WPI 118 (four channels on the WPI 
214), but it can calculate data on up to 128 channels. The extra channels can be used to display 
computed functions that are mathematically derived from the raw data. For example, the arterial 
pressure from eight different animals could be recorded on channels 1-8. Simultaneously, the 
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Rate function could be used on Channels 9-16 to calculate the heart rate of each animal from its 
recorded blood pressure on Channels 1-8. As with any multi-channel display, the more channels 
displayed means there is less space that can be given to each channel. In the case of a 16-
channel Main window display, it is hard to resolve detail in the trace of recorded data in each 
channel. 

DataTrax2 solves this problem by allowing the user to create many different arrangements of 
channels that can be displayed on the screen at one time. Each arrangement of channels that is 
displayed is known as a View. Using the example from the previous paragraph, a View could be 
created that displayed the arterial pressure from Channel 1 and the calculated heart rate for the 
same animal displayed on Channel 9. The data from Channels 1 and 9 would appear in the first 
and second data display areas, respectively. The other fourteen raw data and computed heart 
rate channels would not be displayed. For the data recorded from another animal on Channel 2, 
another view with Channels 2 and 10 (its matching rate channel) can be created. 

Using Views To create a new View, click on the View Control in the Toolbar and choose New View. Name 
the view in the Edit View Name dialog. You can now edit the view by choosing the Edit View 
option from the View Control, by resizing the channels in the Main window, or by hiding or 
minimizing the channel from the Channel menu. 

Edit View You can access the Edit View dialog from the View Control on the Toolbar. For each view you 
can add or remove the Channels available in the View. You can also organize them vertically. 
Each view has its own Voltmeter Panel and you can choose the channels in the voltmeter and 
their position. 
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Note: Any changes to the default view, will also be made to the preferences and vice-versa.

Channel Sizing

 Figure 3-8: The height of the data displays for four channels in the Main window as set by the default setting (top), and after the 
handle for Channel 1 was slid down (bottom).

In addition to scaling the height of the signal to fit in a given channel area, the amount of 
display area allotted to each channel in the Main window can be controlled by clicking and 
dragging on the top of the channel bar. To change the allocated space for a channel, click on the 
top of the channel bar and drag it up or down (Figure 3-8 on page 27). 

Converting 
Units

When used with WPI or National Instruments hardware, the DataTrax2 software functions as a 
calibrated voltmeter, which means the software will accurately display the exact voltage that the 
user presents to the analog-to-digital converter. The displayed (and default) units will always be 
Volts. While this is useful in many cases, it is not always the most appropriate unit. 

If the DataTrax2 software is used to record the output of a transducer designed to measure a 
physical parameter, such as force or pressure, other units are more appropriate. In these cases, 
Volts can be changed into milligrams or grams. The DataTrax2 software can handle these 
conversions easily, provided that the function (or transducer) that relates voltage to real units is 
linear.

The first step in converting voltage input to real units is to record a portion of data at two 
known values. In the case of a force transducer, record output at two known forces such as zero 
and 100 grams. The recorded trace may look something like Figure 3-9 on page 28.
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 Figure 3-9: Data file of weights hung from a transducer and the units conversion dialog window that sets volts to grams.

Once recording is complete, proceed to the 2 Cursor mode in the Main window. (See the 
Cursors section of this chapter.) The Units Conversion dialog window cannot be entered 
without being in 2 Cursor mode. Position Cursor 1 over one of the known values, and Cursor 2 
over the other known value. 

 Figure 3-10: The Units Conversion dialog window showing the 2-point calibration boxes.

Select the Units menu from the Channel menu or by clicking on the Value display area on the 
channel bar. Select the Simple Units Option. The Units dialog window will appear. The typical 
conversion of the output of a transducer is a 2-point calibration, which is the default conversion 
method (Figure 3-10 on page 28). Below that menu is an area where the values for the positions 
of the cursors are listed. The values on the left are the voltage values at the positions of 
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Cursors 1 and 2. Enter the corresponding values in real units into the two value boxes on the 
right. In the Name area, enter the name of the unit to be displayed on the Y-axis. If a unit name 
is not entered, Volts will be used as a default name.

 Figure 3-11: The Units Conversion dialog window showing slope and offset boxes.

It is also possible to set the slope and offset directly, if those values are known (Figure 3-11 
on page 29). For example, if a pressure transducer produces 5mV (0.005V) per mmHg, the 
slope would be 0.005 and the units would be mmHg. To use slope in a units conversion, the 
slope must be expressed as Volts/unit. Ideally, when a sensor puts out zero volts, the value of 
the converted units would also be zero. For many sensors this is true. However, there are many 
sensors that can have their offset changed by ambient conditions, such as changing barometric 
pressure. To correct for sensor offset, determine the value (in converted units) that DataTrax2 
reports on the screen when the sensor should be reading zero. Enter this value in the offset 
area of the Units Conversion dialog window.

 Figure 3-12: The Units Conversion dialog window showing offset only boxes.

Sometimes, it is necessary to keep the units conversion relationship and change the offset, 
like turning the offset control on an amplifier. For example, if we want to set a particular region 
to zero, set the two cursors around the desired region of data. Select Units from the Right-Click 
menu. Choose Offset Only from the drop-down menu (Figure 3-12 on page 29). The average 
value between the two cursors can now be set to the required offset value (zero, in this 
example).

The units are always applied to the selected block(s). To apply the units to all blocks, select 
the Apply units to all blocks checkbox. To apply units to new data which will be recorded select 
the Apply units to new data checkbox.
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Units can also be set from the Channel page of the Preferences dialog window. Each channel 
can be set with the conversion factors provided by the transducer manufacturer (see the section 
on Preferences in this manual).

All of the recorded data, acquired by the hardware as raw data, are displayed as voltages. 
From time-to-time, it may be desirable to turn off the Units Conversion and simply view the raw 
data. To view raw data, open the Units Conversion dialog window (Figure 3-10 on page 28). 
Notice that the program reports the current values in voltage at each cursor and the represen-
tative converted values. Selecting Units Off in this dialog window returns the original display to 
Volts as the default unit.

From the Units menu you can also Zero all Blocks, which takes the value between the 
cursors and sets that value to zero for all blocks. 

From the Units menu, you can also turn off the units for all blocks.

Inverting the 
Trace

When recording physical parameters, such as temperature, pressure or force, it is best if the 
polarity of the data display matches the real-world behavior of the parameter. For example, if the 
observed temperature goes up, the trace on the computer screen should go up. Increasing 
pressure or force should also produce a positive or upward deflection of the trace. 

Depending how sensors and amplifiers are wired, this may or may not be the case. In the 
event that the data display has the wrong sense or polarity, the trace can be inverted by 
selecting Invert from the Channel menu, Units menu, or the Right-Click menu of any data 
channel. As with Units Conversions, the Invert function can be switched off at any time. 

Marks The DataTrax2 software can record large amounts of data, but the data of interest must easily 
be located and retrieved to be useful. Also, information needs to be extracted from the data to 
make it useful. To locate specific sections of data and to differentiate parts of the record from 
one another, it is possible to put Marks on the data while DataTrax2 is recording. Marks are one 
of three navigation tools provided by the DataTrax2 software. In addition to being made on-line, 
Marks can be inserted and edited after the recording has stopped.

Making Marks 
On-Line

Marks (and their associated comments) can be placed on the recording without interrupting 
the flow of data to the computer. 

As soon as the Start button is clicked and data recording begins, the DataTrax2 program sets 
an active text cursor on the Mark line, next to the Mark button on the Main window. On the Mark 
line, the user can type a comment describing an upcoming step in the experiment. The comment 
will be associated with the next mark that is placed on the recording. 

The mark is placed on the recording when the Enter (or Return) key on the keyboard is 
pressed, or the Mark button on the Main window is clicked. The mark will be signified by a 
vertical black line that is inserted on the data at the moment the Enter key is pressed or the 
Mark button is clicked. When recording is halted, the typed comment that was loaded on the 
Mark line prior to the event can be seen in the Text Display area at the bottom of the screen.

A mark is time-locked to the record at the moment the Return or Enter key is pressed. An 
unlimited number of marks can be attached to the record. The vertical line on the recording that 
is associated with a mark is provided as visual confirmation that the mark has been placed.
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Preset Marks If you know the marks that you will be adding to the record prior to recording, you can store 
the mark text as preset marks. To create a preset mark, type in the mark text in the Mark 
window, and choose the Add to Mark Presets option by clicking on the down arrow next to the 
Mark button. This will save the typed text as a preset mark, which can be called by clicking on 
the Mark drop-down box and choosing the desired preset mark. This loads the Mark window 
with the desired mark text, now clicking the Mark button or hitting Return will add the preset 
mark to the record. 

You can delete a preset mark by selecting Preset Mark from the Mark drop-down box and 
choosing the Delete from mark presets option by clicking on the down arrow next to the Mark 
button.

Making Marks 
Off-Line

Marking events as they happen is a necessity for events that are time critical, like drug deliv-
eries or experimental interventions. Information about the experiment that is important, but not 
time critical, can be marked on the recording after the recording is completed. An example of the 
type of comment to be added to the record would be a change in room temperature. 

To add this information to the record after recording is completed, select the Single Cursor 
mode from the DataTrax2 toolbar. Position the single cursor bar on the record where the mark is 
to be positioned. Type the text (a maximum of 50 characters), associated with the new mark, on 
the Mark line in the Main window. Click the Mark button and the mark and its text comment are 
inserted at the position of the cursor.

Editing Marks Marks already on the record can be changed by going to the Marks window, available from the 
Window menu or the DataTrax2 toolbar. The Marks window is a dialog box containing a list of 
all marks in a record (Figure 3-13 on page 31).

 Figure 3-13: The DataTrax2 Marks window.

To edit a mark, highlight the mark, by clicking twice on the mark text.
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Navigating By 
Marks

Marks that are placed on the recording can serve as “sign posts,” indicating where important 
sections of data are located. Click on the down arrow next to the Mark button and choose the 
mark you want to “go-to.” DataTrax2 software will find the data point associated with that mark 
and display that section of data in the Main window. In this manner, the user can move between 
important areas of an experiment without hunting or scrolling for the areas of interest.

Positioning Mark 
Comments

On presentations or printed copies of the data record, it is useful to position the text of the 
comment associated with a mark directly over the data to which it applies. This is particularly 
useful if more than one channel of data was recorded and the mark does not apply to all 
channels.

 Figure 3-14: Comments moved on to the channel data display in the Main window.

When marks are created, the comments appear in the Text Display area at the bottom of the 
Main window above the Time axis. After recording has stopped, comments associated with 
marks can be dragged into the data area of the record. The text of these comments can be read 
and printed in any window in which the data appears (Figure 3-14 on page 32).

Sometimes, it is necessary to return the marks in a particular view to the Text Display area at 
the bottom of the Main window. To do this, click on the down arrow next to the Mark button and 
choose Reset Location of displayed marks. This command returns only the mark comments 
on the data window of the current screen of data to the bottom of the Main window. All other 
marks will remain where they were originally positioned. 

Exercise 1 Click Start and record a few minutes of data. 

2 As data is being recorded, type the word “Test 1” on the keyboard and strike the Return or Enter key on 
the keyboard.
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3 Wait one minute, type “Test 2" and strike the Return or Enter key.

4 Click Stop. Scroll through the data using the scroll bar on the bottom of the Main window until you 
locate “Test 1” in the Text Display area.

5 Click on the down arrow next to the Mark button and choose “Test 2". Notice that the record in the Main 
window has moved to the “Test 2" mark.

6 Using the mouse, click and hold on the comment “Test 2" at the bottom of the screen. Continue holding 
the mouse button down, and drag the mark comment to a new position on one of the available 
channels. 

7 Release the mouse button and the mark is locked on the selected channel. Comments positioned in this 
way will remain where they are placed and will print exactly as you see them. 

8 Try this exercise again with a mark created off-line. To create an off-line mark, open the Single Cursor 
mode by clicking the Single Cursor icon in the DataTrax2 toolbar. Position the cursor where the off-
line mark is to be positioned. Type some text on the comment line at the top of the screen, and press the 
Return or Enter key. The mark appears at the cursor location and the comment appears at the bottom 
of the screen.

Sorting and 
Exporting Marks

The Marks window displays the Time that a mark was made, the text comment attached to the 
Mark, the Channel on which the mark was made and the Value of the amplitude at the mark. 
Marks can be sorted by Time, Channel or the text comment of the Mark by clicking on the 
column titles. Click once to organize marks in ascending order and a second time to change to 
descending order. 

Using the standard Windows commands, SHIFT-CLICK and CONTROL-CLICK, specific marks 
can be highlighted. Once selected, use the Export button to send selected marks to a text file 
which can be opened in Excel or another spreadsheet program.

Voltmeter Large digital readouts of the amplitudes recorded on each channel can be displayed on the 
right side in the Main window. Select the Voltmeter function from the View menu to display 
these readouts. While data is being recorded, the most recent value is displayed. Also it 
displays the amplitude of the trace on each channel at the position of a Single Cursor, or can 
display the difference in amplitudes between the positions of 2 Cursors on each channel. As 
discussed in the section on Views, the voltmeter display can be independently organized for 
each view. You can set the fonts for the title and the value display as well the number of 
columns displayed from the Options menu in the Voltmeter panel.

Online XY In OnlineXY mode, the Y-values from one channel in the Main window are plotted in real time 
against the Y-values from another Main window channel. The resulting XY plot is dramatically 
different from a linear plot of data against time. Select the OnlineXY function from the View 
menu to display this plot. Select the Y and the X channel from the drop-down box, at the bottom 
of the plot window. The Main window display time also applies to the OnlineXY plot.
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 Figure 3-15: Online XY

Display Considerations in Other Windows 
Data is only recorded in the Main window. However, other windows can receive selected data 

from the Main window for closer examination or display in another format, like an XY plot or 
FFT. There are several viewing options available in these other windows that are not available in 
the Main window. The actual discussion of analytical functions found in these windows is 
deferred to the Analysis chapter later in this manual.
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Chapter 4: Controls

Menus

File The DataTrax2 software supports all of the elements found in a standard File menu: 

 Figure 4-1: The DataTrax2 File menu.

New: Opens a new file. Only one acquisition window may be open at a time. This function 
is also available from the toolbar.

Open: Opens a previously recorded file and is also available from the toolbar.

Save: Saves data to the file currently open and is also available from the toolbar.

Save As: Saves data to a new file with a different name or format.

Export: Allows the user to export the data viewed as text, a picture or in a variety of formats 
appropriate to external analysis programs.

Doc Properties: Shows sample speed, gain and other information concerning the data in the 
file.

Print View: Prints the window in the foreground and is also available from the toolbar.

Print Preview: Previews the image to be printed.

Page Setup: Dialog box for control of the printing characteristics.

Print Journal: Prints the Journal.

Print All: Prints the complete data file including the Journal.

Recent Files: Displays the last four files used.

Exit: Quits the program.
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Edit The DataTrax2 software supports elements found in a standard Edit menu: 

 Figure 4-2: The Edit menu.

Undo: Un-does the last command (Journal Only).

Redo: Re-does the last command (Journal Only).

Cut: Cuts the selection (Journal Only).

Copy: Copies the window in the foreground or selection in the journal to the clipboard for 
pasting. Also available from the toolbar.

Paste: Pastes the contents of the clipboard to the Journal (Journal Only).

Preferences: Calls a multi-page dialog box that controls settings for Channels, Sampling, 
Stimulator, Sequences, Options and Events items.

View The View menu supports display elements unique to the DataTrax2 software.

 Figure 4-3: The View menu.

ToolBar: Hides or displays the DataTrax2 toolbar.

StatusBar: Hides or displays the Windows status bar.

Stimulator Panel: Hides or displays the Stimulator toolbar.

Voltmeter: Displays amplitude values in large type and in digital voltmeter fashion.
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OnlineXY: Displays realtime XY plot to the right of the Main window channels.

Main Window: Brings the Main window to the foreground. Also available from the 
DataTrax2 toolbar.

Analysis: Brings the Analysis window to the foreground. Also available from the 
DataTrax2 toolbar.

XY View: Brings the XY View window to the foreground. Also available from the 
DataTrax2 toolbar.

FFT (Spectrum): Brings the FFT window to the foreground. Also available from the 
DataTrax2 toolbar.

Journal: Brings the Journal to the foreground. Also available from the DataTrax2 toolbar.

Marks: Opens a submenu with controls for editing, adding, or resetting marks.

Reset Channel Size: Returns all open channels to their default screen spacing.

Tools The Tools menu provides functions that can find and move specific data points to tables 
created in the Journal.

 Figure 4-4: The DataTrax2 Tools menu.

Add Data to Journal: Sends the calculated values for the selected Table Functions from the 
Analysis or ScopeView windows to the Journal.

Add Titles to Journal: Sends the titles of the calculated values for the selected Table 
Functions from the Analysis or ScopeView windows to the Journal.

Find Hardware: Identifies and initializes the computer’s connection to the WPI data acqui-
sition device.

Find: Calls a dialog box for programming the placement of cursors on data displayed in the 
Analysis or ScopeView windows.

Find Next: Finds the next data point in the file which meets the criteria set in the Find box.

Auto Find: Automatically finds each successive data point in the file that meets the criteria set 
in the Find dialog box. Calculated values from the Table Functions selected in the Analysis 
window are automatically added to the Journal for each matching data point.

Auto Mark: Calls a list of functions that can automatically locate characteristic data points, 
like the LVEDP or QRS, in a data file displayed in the Analysis or ScopeView window.

Delete Block: Can be used in the Analysis window to delete the current block. Warning: This 
cannot be undone!
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DownSample: Used to downsample the data. This reduces the information in the file and 
should be used with caution. Warning: This cannot be undone!

Settings The Settings menu lets you load and edit files containing preset recording and analysis 
parameters. Selecting a file from the list programs DataTrax2 to record data in a specified 
manner. Settings files have been preprogrammed for each DataTrax2 experiment and specific 
settings are associated with each lab exercise.

 Figure 4-5: The Settings menu.

Load Group: Loads a group of existing setting files. Each file contains the recording and 
analysis parameters needed in DataTrax2 to record a specific experiment or type of data.

Edit Group: Allows the user to edit existing settings files in a group, remove them from a 
group or to add new ones to a group.

Cardiac, Respiration: Examples of the categories within a settings group.

Tutorial, BloodPressure-BodyPosition, Diving Reflex etc.: experimental settings in a group.

Scripting Not yet implemented.

Help The Help menu provides links to information about the DataTrax2 software and hardware.

 Figure 4-6: The Help menu.

Tip of the Day: Selecting this function displays an important bit of information.

Help (Manual): Sends user to the on-line version of the DataTrax2 software manual. Also 
available from the toolbar.

WebPage: Takes the user to the WPI home page.

Language: Allows user to change the language.

About DataTrax2: Displays version and copyright information pertaining to the DataTrax2 
program.

Send a Bug Report: Sends a bug report. You need to be connected to the internet.
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Check for Updates: Checks the DataTrax2.com website for the latest version of the software. 
You need to be connected to the internet.

Toolbars

Main Toolbar

 Figure 4-7: The toolbar in the DataTrax2 Main window.

New File: Opens a new file. Only one acquisition window may be open at a time.

Open File: Opens a previously recorded file. 

Save File: Saves data to the file currently open. 

Main Window: Brings the Main window to the foreground.

Analysis: Brings the Analysis window to the foreground.

XY View: Brings the XY View window to the foreground.

FFT (Spectrum): Brings the FFT window to the foreground. 

Journal: Brings the Journal to the foreground.

Marks: Brings the marks list to the foreground. 

Stimulator Preferences: Hides or displays the Stimulator toolbar.

Half Display Time; Reduces the time displayed on the screen by a factor of 1/2, each 
time the icon is clicked.

Zoom between cursors: Zooms to the area selected by the two cursors.

Double Display Time: Increases the time displayed on the screen by a factor of two each 
time the icon is clicked.

2 Cursor Mode: Click icon to display two cursors on the data window. Time and voltage 
differences between the data points intersected by the cursors are measured.

Single Cursor Mode: Click icon to display one cursor on the data window. Absolute time 
and voltage from the beginning of the trace to the cursor are displayed.

Views: (Shown in the above toolbar as default view).
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Clicking on the down arrow next to the view name, brings up the View 
control menu. You can switch the current view from this menu, create a 
new view from the default view, duplicate the current view, rename the 
current view, edit the current view, which brings up a View page of the 
Preferences dialog, or delete the current view.

Sequences:

The Output Sequence Toolbar is a drop-down list containing 
sequences of analog or digital outputs defined in the Sequence 
page of the Preferences dialog window. Clicking the Sequence 
button will fire the output sequence selected from the list. 
Selecting a new sequence in the drop-down list also automatically 
fires that sequence.

Stimulator 
Toolbar

Pulse Mode

 Figure 4-8: The Stimulator Pulse toolbar in the DataTrax2 Main window.

Amp: Amplitude of the stimulus pulse in Volts.

#pulses: Number of Pulses.

Width(ms): Width of the pulse in milliseconds (ms).

F(Hz): Frequency of stimulation in Hertz (Hz) (1Hz=1 cycle/second, in this example, five 
pulses would be given every second. 

HP: Holding Potential

Apply: When clicked applies any changes to the stimulus protocol made through the Stimu-
lator Toolbar. Clicking Apply while recording will send a stimulus pulse from the output. 

Clicking the down arrow next to the Apply button, shows a menu. 
All options in this menu may not be available for all hardware. On 
hardware that allows it, Apply will wait until a “good” time to apply 
the changes, i.e., until a pulse is completed, before changing the 
number of pulses.

•Stop: Stop the stimulator.
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•Apply All: Applies the changes and fires all stimulators. As with Apply, on hardware that supports 
it, the change will happen at the next “best time.”

•Stop All: Stops all stimulators.

•Apply Now: Forces the stimulator to apply the changes as soon as possible.

•Apply All Now: Forces all the stimulators to apply the changes as soon as possible.

Constant 
Mode

 Figure 4-9: The Stimulator Pulse toollbar in the DataTrax2 Main window.

Amplitude: Amplitude of the stimulus in Volts.

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Refer to the pulse mode for additional information.

Train Mode

 Figure 4-10: The Stimulator Pulse toolbar in the DataTrax2 Main window.

Amp: Amplitude of the stimulus pulse in Volts.

#p: Number of Pulses.

W(ms): Width of the pulse in milliseconds (ms).

F(Hz): Frequency of stimulation in Hertz (Hz).

#R: Number of Trains (or Repeat Count).

IP Dur: InterTrain(or inter protocol) duration.

HP: Holding Potential

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output. Refer to the Pulse 
mode for additional information.

Step Mode

 Figure 4-11: The Stimulator Pulse toolbar in the DataTrax2 Main window.

A1: Starting Amplitude.

A2: Stopping Amplitude.

#steps: Number of Steps.

W(ms): Width of the step in milliseconds (ms).

F(Hz): Frequency of stimulation in Hertz (Hz).

#R: Repeat Count.

IP Dur: Inter protocol duration.

HP: Holding Potential.
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Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output. Refer to the Pulse 
mode for additional information.

Dialog Windows

Preferences There are six pages in the Preferences dialog box. 

 Figure 4-12: The pages of the Preferences dialog window.

Channels Page The preferences that can be set for all channels include:

 Figure 4-13: The Channels page of the Preferences dialog window.

Acquisition Mode: Sets the type to acquisition.

Start: Sets the parameters to start recording.

Stop: Sets the parameters to stop recording.

Speed: Sets the number of samples taken every second on each channel.

Display Time: Sets the time and the amount of data displayed on the screen 

The preferences that can be set for each individual channel include:

Title: Edits the title of each channel to better identify the parameter being recorded.

Mode: Sets the record or the display mode of the channel. Channels 1 and 2 on the WPI 214 
(Channel 1 only on the WPI 114) have record modes which allow either the bioamplifiers to be 
activated with a bandpass filter (0.03-150Hz, 0.3-35 Hz, or 3-10KHz) or the BNC input to be 
activated for recording signals from other devices with analog outputs.

Function: Selects either Raw Data or one of the many available calculated values to be 
displayed on the channel.

Ymax, Ymin: Sets the maximum and minimum Y-axis values.

add function: used to add a computed function to a channel.
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Units: Used to convert two raw data values to two corresponding calculated values, using a 
linear scale. For more information refer to the Units Conversion section

Color: Sets the color of the channel.

Stimulator Page Used to setup the Stimulator(s) on the WPI 214/118. There are five modes: Off, Pulses, 
Trains, Constant and Step. The available parameters in each of these modes can be preset 
and made part of a settings file. 

Refer to the Stimulator section of the Input/Output chapter for information on the 
programming of the stimulator.

Views Page Refer to the Display chapter for information on configuring this page.

Sequences Page Refer to the Digital Inputs and Digital Outputs sections of the Input/Output chapter for infor-
mation on configuring this page.

Options Page These settings are at the application level and will apply across different settings files.

 Figure 4-14: Options page of the preferences dialog

Display: The colors and line thickness, etc. can be changed here.

MainWindowFunctions: Allows the user to select the functions available from the Main 
window.

Data display precision: The number of digits of precision to be shown.

Data Separator: The data separator to be used for exporting data to the journal.

Maximum display points: The maximum number of data points that will be displayed.
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Chapter 5: Analysis

Overview
Today’s analog to digital converters make acquiring data very easy. The challenge to all users 

is to extract meaning from the mountains of recorded data in order to generate conclusions, 
reports, and Nobel Prizes. This process is called analysis. 

Built into the DataTrax2 data recording software is a powerful array of data analysis tools. The 
variety of tools available strike a balance between the straightforward, general operations that 
everyone uses and the vertical, complex routines that only YOU use. So, DataTrax2 is a 
powerful analytical tool that can go to work on data right away, or be customized to execute very 
specific, complex analysis routines. 

Analysis in DataTrax2 is divided into five kinds. Each kind addresses specific analytical 
requirements. The following sections of this chapter explain how each kind is used.

Analyses of the First Kind: Wave-to-Wave Transforms
Analytical functions of this kind take ALL of the data in a channel and apply a transform, which 

converts the entire waveform described by the data points into a completely new wave that is 
displayed on a different channel. Examples of this kind of analysis would be the first derivative 
or the integral. 

Currently there are more than 50 functions of the First Kind, or Wave-to-Wave Transforms, 
included in the DataTrax2 program. These functions can only be accomplished on the Main 
window. They are called by using the Add Function menu and can be used on-line or off-line. 
When used on-line, the functions can operate at the top acquisition rate of the program, 
100,000 samples per second.

In the Add Function menu, the transforms are organized into groups. 
The functions within a group have similar setup requirements and are 
usually located in a submenu. While the list of available functions is 
always expanding, DataTrax2 V2.x includes the following groups: 
Periodic, Integral, Derivatives, Spirometry, MultiPoint Calibration, 
Channel Math, Filter, Smoothing, Power, Cardiac, EEG, Gain 
Telegraph and Digital Input Functions. Each group is discussed 
below.

Before beginning to explain the various First Kind functions, it is 
appropriate to ask: “Where does the raw data for a wave-to-wave 
analysis come from?” It is a question that is appropriate for all of the 
First Kind functions. To apply a function on a Raw Data or a 
Computed Data channel click the Add Function button on that 
channels Channel bar. Choose the desired function from the menu. If 
the function requires user specified parameters, a setup dialog will 

automatically appear. This setup dialog is also accessible after the Computed Function 
channel has been created, from that computed channel’s Mode/Function label in the Channel 
Bar.

Whether calculated functions are performed on-line (in real time) or off-line (after recording 
has stopped), their setup is the same. 
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Note: Deleting the raw data channel will cause the function channel to have invalid data.

Periodic Periodic functions operate on cyclic data to produce a graphical representation of how the 
Rate, Frequency, Period, Cycle Maximum, Cycle Minimum, Cycle Mean, or RMS (Root Mean 
Square) vary with time. The program calculates these parameters with each cycle of the signal 
and displays the calculation on the screen. 

Threshold To make these types of calculations on each cycle, the software must have a way of defining a 
cycle of data. As data is collected on-line or processed off-line, the DataTrax2 program begins 
the calculation by using the AutoScale feature to determine the Max and Min values in a given 
screen of data. Then, the program uses a Threshold value to find points on the recording where 
the trace repeatedly crosses the threshold with a positive slope. The control for the Threshold 
level is set in the Periodic setup dialog, which appears when a periodic function is selected. 
The Threshold level can be set at X% of maximum value in any given screen of data or an 
absolute value. By default, X% is set to 60%, which is adequate for almost all biological signals. 
The Threshold value can be changed by entering a different number in its box. Finally, the 
program defines the time between the points, where the recording repeatedly crosses the 
threshold line with a positive slope, as a Period (Figure 5-1 on page 45).

 Figure 5-1: The Periodic setup dialog window.

Tolerance A second Periodic control known as Tolerance, or hysteresis, is present in the Periodic 
setup dialog window. Tolerance is used to reduce false triggering due to noise in the signal. By 
default the tolerance is set at 3%, if the threshold is set at 60% then the signal has to cross from 
below 58.5% (60 - 3/2) to above 61.5% (60 + 3/2) for a threshold crossing to be detected. The 
maximum value between two threshold crossings is taken to be the peak, and adjacent peaks 
are used to calculate the periodic functions.
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Exercise To see Threshold and Tolerance in use, record some pulse data using the Tutorial setting 
from one of the Settings groups. Apply the Rate function to the pulse channel. 

The Rate function must be able to ignore the second small wave associated with each larger 
pulse wave; otherwise, it will report a rate that is twice what it should be. Using the Rate 
function on an ECG would mean that Threshold and Tolerance should be set so that only one 
wave of the three separate and distinct waves per beat can be counted. 

Activating Periodic 
Transforms

All Periodic functions are selected in the same manner. To apply any of 
these functions to a channel, click on the Add Function button in the 
Channel bar. Select Periodic from the Function menu and a submenu 
appears. Select one of the functions in the submenu. Click Start in the Main 
window to begin recording. AutoScale the raw data, then AutoScale the 
calculated channel. No other setup is required.

The functions in the Periodic submenu are:

Rate: The program takes the period in seconds and divides this value into 
60. The result is a rate, which is expressed in beats per minute

Frequency: The program takes the period in seconds and divides this value 
into 1. The result is a frequency, which is expressed in Hz or cycles per 

second.

Period: The program takes the Period for each cycle.

Cyclic Min: The program examines all of the points in the current period and finds the lowest 
value.

Cyclic Max: The program examines all of the points in the current period and finds the highest 
value.

Cyclic Mean: The program examines all of the points in the current period and finds the 
average of all values.

Max dV/dt: The program examines all of the derivatives in the current period and finds the 
highest value.

Mean dV/dt: The program examines all of the derivatives in the current period and finds the 
average of all values.

Min dV/dt: The program examines all of the derivatives in the current period and finds the 
lowest value.

RMS: The program examines all of the points in the current period and finds the Root Mean 
Square value for all points.

Integral The integral is the area under the curve. The Integral function, as executed by the DataTrax2 
software, calculates a continuous sum of all the data points on a given channel that satisfy a 
certain citeria, and plots the running total. There are four types of Integrals: 

Standard: Includes all data points in the calculation

Absolute: The Absolute Value of the Integral (Abs. Integral), as the name implies, makes all 
values of the integral positive and plots the running total. The Abs. Integral is used for analysis 
of cyclic data such as unit action potentials or EMG data.

Positive: Only the positive data points are included in the calculation.
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Negative: Only the negative data points are included in the calculation.

Data points with values above zero make the Integral larger, those with values less than zero 
make the Integral smaller. To successfully complete the calculation of the Integral, the location 
of the zero-line needs to be known. 

Setting the baseline of the raw data channel to zero is the more important of the two require-
ments since this function defines the difference between positive and negative areas of the 
recording. If the baseline of the raw data record is in the positive range of amplitudes, then the 
Integral will have a positive slope, even though no signal is present. Conversely, if the baseline 
of the raw data is in the negative range, the Integral will have a negative slope.

Zero As mentioned above, the Integral function adds the amplitudes of successive data points and 
plots the total. The problem is determining where the zero-line is located. DataTrax2 and most 
other data programs take the value zero volts as the zero-line. If real units, such as grams or 
mmHg are used, the DataTrax2 software will take the zero units value as zero. 

DataTrax2 also has a Use First “Number” seconds as zero option. The data values for the 
first “Number” of seconds collected are averaged and used by the program as zero. This 
feature is particularly useful when trying to integrate signals that are difficult to zero manually. 

An example of the application of this feature is illustrated in Figure 5-2 on page 47. The output 
of a respiratory flow sensor is the raw data displayed on the upper channel in each window; the 
lower channel in each window is the integral of the upper channel, or the volume flowing through 
the sensor. 

In this example, the setting of zero is critical because any offset of the raw data from zero will 
be taken as a flow and, subsequently, be interpreted as a volume. Two examples of the respi-
ratory integral are shown. In each case the flow sensor has a small, but stable offset. In the first 
example, the integral shows constant increase in volume, even as the flow is constant. In the 
second record, where the Use First “Number” seconds as zero option is used, the initial flow 
is constant and is set to zero, so the initial volume is zero. When the flow increases to a level 
above the “effective” zero-line, then the volume will increase on the integral channel. 

 Figure 5-2: Integral without Zero.
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 Figure 5-3: Integral with Zero

The Reset control in the Integral 
Setup dialog window determines when 
the Integral or running count will reset 
itself to zero. This option allows the 
Integral to reset itself after a preset 
time. This is a useful option if the data 
being integrated contains artifacts that 
move the Integral artificially up or 

down. The Reset function keeps the Integral trace in the field of view. In the respiration 
example, if inhaled air is at 20oC and exhaled air is closer to body temperature, then exhaled air 
has a larger volume. Since the subject exhales more than he or she inhales, the integral record 
will have a slow upward drift. Resetting the trace periodically will return it to zero.

Activating Integral 
Transforms

All Integral functions are selected in the same manner. To apply any of these functions to a 
channel, click on the Add Function button in the Channel bar. Select Integral from the 
Function menu and a submenu appears. Select one of the functions in the submenu. Click Start 
in the Main window to begin recording.

Derivative The Derivative function calculates the derivative at each point in the raw data, and then 
displays it on the calculated channel. On the channel where the Derivative is displayed, the 
units are changed to the units of the raw data channel/second. Higher order derivatives can be 
calculated by applying a derivative function to a derivative channel.

Activating 
Derivative 
Function

To apply the derivative function to a channel, click on the Add Function button in the Channel 
bar. Select Derivative from the Function menu. Click Start in the Main window to begin 
recording.

Spirometry The Spirometry function is a specialized version of the integral function for use with the WPI 
spirometer. This transducer, which measures respiratory volumes, is a sensitive air flow sensor. 
DataTrax2 integrates the flow values measured by the sensor and displays volume. The settings 
for this integration are specifically designed for volume calculations. 

Each WPI spirometer has a calibration value on it. This value can be entered in the 
Spirometer Calibration window. If the user has a calibration syringe and has recorded data 
where a known volume of air was pushed through the spirometer, this data will be displayed in 
the graph window. Place the first cursor at Zero Volume and the second cursor at X Volume. 
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Also enter this X value in the text box below the graph. Clicking the Calibrate Difference 
between Cursors button will calculate the required calibration value and place it in the 
Spirometer Calibration window. 

To account for offset in the spirometer, choose a time at the beginning of the record when 
there is no flow through the spirometer and enter this value in the Use First N Seconds as Zero 
text box. DataTrax2 will take the first N seconds, average them together and use the result to 
set the zero-line of the Volume channel. This is necessary because the output of the air flow 
sensor is always offset and any offset causes the Volume channel to display a volume change, 
even though no air is flowing through the sensor.

The Volume integral can also be set to reset after a certain time or with every cycle. During 
spirometry experiments, the volume trace drifts upward because the volume of exhaled air is 
larger than the volume of inhaled air. Cooler inhaled air at room temperature occupies less 
volume than warmer exhaled air. The Volume integral will drift up and out of view, as it reports 
correct values, unless a periodic reset is employed. 

Activating 
Spirometry 
Function

To apply the Spirometry function to a channel, click on the Add Function button in the 
Channel bar. Select Spirometry from the Function menu.

Channel 
Math

The Channel Math function applies a user-defined function to points from up to four data 
channels and displays the output in a computed channel. There are four Variables A, B, C and 
D, each of which can be associated with a user selectable data channel. For example, if you 
wanted to divide Channel 1 by Channel 2. Click on the Add Function button on either the 
Channel 1 or Channel 2 channel bar. Select the Channel Math option. Select A to be Channel 1, 
and B to be Channel 2. Set the channel value to be A/B.

 Figure 5-4: The Channel Math dialog window. eg, output channel is equal to (RawCh 1 plus Raw Ch 2 / 2) * Comp Ch 1 in grams

The result is every Channel 1 data point divided by the corresponding Channel 2 data point. A 
full range of trig and log functions, as well as the common mathematical operators, are 
available in the Channel Math dialog window. The Unit Name for the calculated value can be 
specified in a box. There is also a Check Expression feature, which will check for errors like 
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unclosed parentheses or division by zero. Since division by zero is a possible occurrence even 
in legitimate expressions, but it cannot be calculated by a computer, the program substitutes the 
last calculated value for the quotient if division by zero is attempted.

Activating 
Channel Math

To apply the Channel Math function to a channel, click on the Add Function button in the 
Channel bar. Select Channel Math from the Function menu. Select the channels corre-
sponding to A, B, C and D. Program the expression desired. Set units if desired, and click OK.

Filter Each channel has its own digital filter that can be used on-line or off-line. DataTrax2 uses a 
FIR (Finite Impulse Response) filter. There are various windowing functions that can be used 
for setting up an FIR filter. The Hamming window (default) is appropriate for most applications. 
In addition to this windowing function DataTrax2 also provides Rectangular, Bartlett, Hanning, 
Blackman and Blackman-Harris windowing functions. The filter order is the number of data 
points in the raw data required to calculate each point in the filtered data. The strength of the 
filter is determined by the filter order. The higher the order, the stronger the filter. Note that the 
higher the order the longer it takes to calculate, which can slow down the display. Also the first 
and last order/2 data points in the filtered data are invalid. For example, if the filter order is 51, 
then the first 25 and the last 25 data points in the filtered data are invalid. 

 Figure 5-5: The digital (software) Filter dialog window.

In the Filter Setup dialog, drag the boundaries of the filter or enter the values in the Low 
Cutoff and the High Cutoff fields to create the desired filter. The graphic interface in the Filter 
Setup dialog is straight forward. The colored area corresponds to the frequencies that are 
passed, and the white area corresponds to the frequencies that are rejected. To remove high 
frequencies from the signal, click on the right boundary of the colored area and drag this 
boundary to the left. To remove low frequencies from the signal, click on the left boundary of the 
blue area and drag this boundary to the right. After clicking and dragging a boundary, it can be 
placed more accurately by entering the values in the Low Cutoff and High Cutoff fields. Bound-
aries can be placed in configurations that create High Pass, Low Pass, Band Pass (as shown 
in Figure 5-5 on page 50), or Notch filters.
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Notice that the filter is subject to the Nyquist limitation of frequency. The maximum frequency 
in the Filter Setup dialog is exactly half of the sample frequency.

Smoothing All experimental data includes noise to varying degrees. Noise can obscure important features 
like peaks, valleys, or peak widths. DataTrax2 allows you to smooth noisy signals to reveal 
significant features of your data. In addition to filters, DataTrax2 also offers the ability to smooth 
the data. Smoothing is used to remove noise that is uniform across all frequencies. Each 
method offers different performance to best show significant aspects of your results. Filtering 
allows you to eliminate noise above a specified frequency. DataTrax2 provides two kinds of 
smoothing; Moving Average does wide smoothing, while Savitzky-Golay seeks to preserve 
shapes of peaks.

Moving Average: Applies a user specified number of points on either side of each data point 
to calculate the mean and replaces the datapoint with the calculated mean. For example, if you 
set the number of data points on either side to 1, then 

new data (N) = {data(N-1) + data(N) + data(N+1)}/ 3

Savitsky-Golay: The Savitzky-Golay method essentially performs a local polynomial 
regression to determine the smoothed value for each data point. This method is superior to 
Moving Average because it tends to preserve features of the data such as peak height and 
width, which are usually 'washed out' by adjacent averaging. To use the Savitsky-Golay 
smoothing type, the order of the polynomial and the number of points on each side of the data 
need to be specified.

In addition to smoothing the data, DataTrax2 also provides the option to calculate the 
smoothed 1st, 2nd or 3rd derivative of the data. 

Power The Power function performs a Fast Fourier Transform (FFT) on data in the selected channel 
and returns the average Power in the frequency band selected. 

 Figure 5-6: The Power dialog window.

In DataTrax2, this function works only off-line. The graphic interface in the Power dialog 
window is similar to the one in the Filter Setup dialog. The band of frequencies selected from 
the Power dialog window are not filtered, but they are subjected to an FFT whose output is 
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known as a Power Number. In addition to specifying the range of frequencies transformed, the 
frequency resolution can be selected. The higher the frequency resolution, the more data points 
required to compute the FFT. Therefore, at slow sampling rates, higher frequency resolutions 
may require the processing of more data points from longer recording periods. 

Cardiac The Cardiac functions are specifically used for the analysis of electrocardiograms (ECG). 
Four of the Cardiac functions calculate Leads: III, aVL, aVF and aVR from the recordings of 
Lead I and Lead II. 

You can specify which channel corresponds to Lead I 
and Lead II in the Cardiac Setup dialog. DataTrax2 
can be programmed to do these calculations because 
all the points of view in a 6-lead ECG are in the same 
plane (frontal) of the body and each lead can be 
considered as a vector. So if any two of the limb leads 
are recorded, the other four leads can be calculated 
from them. 

The Cardiac submenu also includes other functions. The Cardiac 
Angle function calculates the vector of the cardiac depolarization 
that passes through the interventricular septum. Three Power 
functions, which are special cases of the general power function 
described earlier, are also available. These three power functions 
are useful for heart rate variability (HRV) analysis. Low Frequency 
(LF) Power (0.04-0.15 Hz), High Frequency (HF) Power (0.18-0.4 
Hz) and Total Power are each calculated from the transformation of 
a tachogram of an ECG on one of the raw data channels. The HRV 
Ratio which is (Low Frequency (LF) Power)/High Frequency (HF) 
Power is also available.

Activating Cardiac 
Functions

To apply the Cardiac function to a channel, click on the Add Function button in the Channel 
bar. Select Cardiac from the Function menu, then select the appropriate submenu. Select the 
channels corresponding to Lead I and Lead II and click OK

EEG The EEG function is another specialized case. 
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In this function, a preset frequency band is available for each 
component of the EEG: Alpha, Beta, Theta, Delta, Betalow, Beta Mid 
and Beta High. For each selected band, DataTrax2 can also calculate 
the average power in the band and display the value against time. 
These are beneficial functions to use when teaching students, because 
they can clearly see the effect that behavior has on components of the 
EEG.

Activating EEG 
Functions

To apply the EEG function to a channel, click on the Add Function button in the Channel bar. 
Select EEG from the Function menu, then select the appropriate submenu and click OK.

Gain 
Telegraph

The Gain Telegraph function is slightly 
different from the other functions. Some ampli-
fiers have an additional output that sends a 
calibration signal to the data recording unit. 
This calibration signal relays information about 
the gain settings of the external amplifier. This 
information permits the recording program to 
re-calibrate the amplifier output in the correct 
units regardless of the gain set on the 
amplifier. 

Using Gain 
Telegraph

Connect the analog output of the supported amplifier to any input channel. For this example, 
assume this is Channel 1. Next, connect the gain telegraph output of the amplifier to any input 
channel. For this example, assume this is Channel 2. 

To apply the Gain Telegraph function to a channel, click on the Add Function button in the 
Channel bar. Select Gain Telegraph from the Function menu. Select the manufacturer of your 
amplifier, then select the amplifier you are using. Select the channel that the output from your 
amplifier is connected to (Channel 1 in this case), then select the Gain Telegraph Channel 
(Channel 2 in this case) and click OK.
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Digital Input The Digital Input function treats the data on the 
selected channel as a binary number.

The functions in the Digital Input submenu are:

Raw: The digital value as a 32 bit word is 
displayed

Frequency: The program takes the period in 
seconds and divides this value into 1. The result 
is a frequency, which is expressed in Hz or 

cycles per second.

Period: The program takes the period for each cycle.

Time On: The time that the selected channels are high.

Time Off: The time that the selected channels are low.

Duty Cycle: 100* (Time On)/Period.

Count: Number of events.

The channels of interest can be 
selected using the checkboxes. If 
you desire to complement the input 
before it is used then click on the 
checkbox again, as shown in the 
legend.

Reset After n sec: This option is 
only available for the Count 
subfunction, which is used to reset 
the count after n seconds.

Any Bit is Set/ All Bits are set: 
Choose if you want an event to be 
detected if any channel is high or if 
you only want an event to be 
detected if all channels are high.
5 Analysis 54



CrossTime 
Channel 
Calculation

Initial Delay: The amount of time from the start of recording until the function is initiated.

Selection Duration: Period of the protocol.

To setup CrosstimeChannelCalculation, you need to setup the Initial Delay before the 
function is initiated and set the Selection Duration to the period of the protocol. Selection can 
be set to start when the data on a selected channel goes above an operator selected value.

For each selection as defined above, variable A can be setup to equal the mean, maximum, or 
minimum of the data between the selected time range on a selected channel. Variables B,C and 
D can be setup in similar fashion.

The title and units name of the computed channel can be set. The variables A,B,C,D and the 
calculator can be used to create an equation for the computed channel.
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MultiPoint 
Calibration

MultiPoint Calibration can be used to perform a linear and non-linear calibration of sensors, 
transducers, amplifiers and other equipment. It can also be used to check if an existing sensor 
is linear.
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Template 
Match

Template Matching is a technique in digital signal processing for finding small parts of a 
signal which match a template. The idea of template matching is to create a model of a signal of 
interest (the template, or kernel) and then to search over the recorded data for objects that 
match the template. To create a template, select a region of interest using the two cursors. Click 
Create Template from data between cursors to create a baseline for the template. For each 
point in the template, you can set the acceptable tolerance. The tolerance can be fixed for all 
points or variable. In case of variable tolerance, you set the high and the low limits of the 
tolerance separately. You can move the complete line up/down using Block Move Cursor, or 
you can move only certain segments of the curve using freehand Move using. When using the 
freehand move, you also have to specify the number of points each move will influence. 

Once a template is created, the program will find segments of the data where each datapoint 
in the segment matches the template within the tolerance for each point. 
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Auto 
Correlation

Correlation is the mutual relationship between two or more random variables (Ali). AutoCorre-
lation is the correlation of a signal with itself (Parr 1999). AutoCorrelation is a mathematical tool 
used frequently in signal processing for analyzing functions or series of values, such as time 
domain signals. Informally, it is a measure of how well a signal matches a time-shifted version of 
itself, as a function of the amount of time shift. More precisely, it is the cross-correlation of a 
signal with itself. AutoCorrelation is useful for finding repeating patterns in a signal, such as 
determining the presence of a periodic signal which has been buried under noise, or identifying 
the missing fundamental frequency in a signal implied by its harmonic frequencies.(Wikipedia 
2007). 
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Analyses of the Second Kind: Digested Data

The functions in this kind of analysis take a group of data points selected by the user and 
"digests" them into a single value. These values can be saved to the Journal within DataTrax2 
or exported to other programs. This kind of analysis can proceed in the Analysis window. There 
are currently 24 functions available in the DataTrax2 program to do this kind of analysis. Some 
of the functions are: Mean, Max, or Max-Min.

Analysis 
Window 
Setup

The Analysis window (see Figure 5-7 on page 60) is used to display and perform calculations 
on selected pieces of data or sweeps captured from the Main window. The data used in the 
Analysis window is defined by the data displayed in the Main window. The data is then captured 
by either clicking the Analysis icon on the DataTrax2 toolbar or selecting Analysis from the 
Windows menu. Data from all channels within the selected area are displayed in the Analysis 
window. 

Many of the same tools in the Main window are also available in the Analysis window. These 
include: Display Time controls; Marks, which are the same as the ones positioned in the Main 
window; and 2 Cursor mode (Single Cursor mode is unavailable). Scroll bars can be used to 
fine tune the area of data upon which the selected functions will operate in Chart mode. In 
Scope mode the sweeps of interest can be selected Individually or as part of a group. 

Data in the Analysis window can be operated upon by the functions selected with the Add 
Function button just above the left hand side of the first channel. Functions are organized in 
three groups: General, Derivative and Integral (Area). To add a function click on the Add 
Function button, choose the Function Group and then the desired function from the submenu. 
The selected function will now appear to the left of the Add Function button. 

Again, the 2 Cursors are positioned on the left and right edges of the data to be analyzed. 
DataTrax2 will immediately calculate and display the values for the selected parameters in the 
Channel Bar of each channel. The precision of the calculations performed is adjustable using 
the Data Display Precision value in the Options page of the Preferences window. 

There are 24 analytical functions available in the Functions list. These functions are 
described below. The values listed in the Channel Bar area can be sent to the Journal for 
formatting and inclusion in reports. To do this, click on the Channel menu (or right-click in the 
channel area) and select Add Ch. Data to Journal, Add Title to Journal or Add All Data to 
Journal. 

Add Ch. Data to Journal: Adds data from the selected channel to the Journal.

Add All Data to Journal: Adds data from all channels to the Journal.

Add Title to Journal: Adds the function titles to the Journal.

The Analysis window can also be copied, printed, or exported to ASCII, .png, or .bmp format 
documents.
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 Figure 5-7: The DataTrax2 Analysis window.

Analysis 
Window 
Components

Functions List The functions selected in the Add Functions list determine the calculations performed on the 
data points between the two cursors in the Analysis window. The results of the selected calcu-
lations are displayed in the Channel bar area at the top of the each Channel .

Tiled or Stacked 
Display

By default, the channels selected for display are presented in Tiled 
mode. Each channel is displayed in its own area, as they are shown 
in the Main window. By clicking the Stacked/Tiled icon in the lower 
left hand corner of the Analysis window, selected waveforms can be 
overlaid on the same set of axes.
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Channel Menu in 
the Analysis 
Window

Clicking on the Channel Menu button or 
right-clicking in the display area of the 
Analysis window brings up the Channel 
menu. 

Add Ch. Data to Journal: Adds data 
from the selected channel to the 
Journal.

Add All Data to Journal: Adds data 
from all channels to the Journal.

Add Title to Journal: Adds the function 
titles to the Journal.

Calculations: Brings up the calculations 
submenu, for performing dedicated 
calculations in Spirometry, ECG, Blood 
Pressure and Peak Analysis. This is 
discussed later in this chapter

Copy Graph: Copies the channel graph 
to the clipboard, This can be then 
pasted into the Journal or any other 
program.

The remaining functions operate in the same manner as in the Main window

Scope Mode 
Display 
Options

In Scope mode, you can view multiple sweeps at the same 
time. Sweeps can be selected and deselected from the 
Sweep Selection bar. Data can be calculated from only one 
sweep at a time. The primary sweep, on which the functions 
operate, is selected in the drop-down box to the left of the 

Add Function bar. The primary sweep cannot be deselected from the Sweep Selection bar.

To manage several sweeps, DataTrax2 provides a Sweeps Manager. The Sweeps Manager is 
available from the Sweep menu button to the left of the Sweep Selection bar. In the Sweep 
Manager, one can organize the sweeps into groups. To create a group, click on the Create New 
Group button and the Edit Group Name dialog will appear. Enter a name for the new group and 
click OK. The group is now listed in the group tree. To add a sweep to a group, select a sweep 
from the available sweeps list and drag it to the group, or click the Add button. To remove a 
sweep from a group, select the sweep and click the Remove button.

To switch the display from Sweep mode to Group mode, click on the Sweep/Group mode 
button to the left of the scrollbar. This button changes between Sweep and Group mode. 

Table 
Functions 

These functions are available in the Analysis window.

General Value1: Value at Cursor 1

Value2: Value at Cursor 2

Time1: Time at Cursor 1

Time2: Time at Cursor 2
5 Analysis 61



. .
 

V2-V1: Value2-Value1, i.e. the difference in value between the cursors

T2-T1: Time2-Time1, i.e. the difference in time between the cursors

Max: Maximum value between the cursors

Min: Minimum value between the cursors

Mean: Mean or Average value between the cursors.

Max-Min: Difference between the maximum and minimum values between the cursors.

Mark: Text of a mark between the cursors

Unit: The units of the channel

RMS: Root Mean Square of the values between the cursors

StdDev: Standard Deviation of the values between the cursors

Count of Events: Number of events between the cursors.

Derivative dV1/dt:Derivative at Cursor 1

dV2/dt:Derivative at Cursor 2

Max dV/dt: Largest dv/dt values for all of the data points between the two cursors.

Min dV/dt: Smallest dv/dt values for all of the data points between the two cursors.

Mean dV/dt: Mean dv/dt for all of the data points between the two cursors. This is also the 
slope of the line of best fit for all the data points between the cursors.

Integral All the integral and area functions are calculated as integrals. 

Area: The Area function uses the line between V1 and V2 as the zero baseline, and then 
calculates the integral.The Area function gives more control over which segments of a waveform 
are included in the integral. 

Abs. Area: The absolute value of each data point is used to calculate the area as described 
above. Areas that would have been subtracted in the Area function, are instead added in the 
calculation of the Absolute Area. 

Int: For the Integral calculation, zero volts (or zero calculated Y-value) is used as the zero 
reference for the integral. Values above zero add to the Integral and values below the zero-line 
subtract from the Integral.

Abs Int: The Absolute Integral is very much like the Integral, except that the program takes 
the absolute value of the raw data before performing the integral operation.

Calculations All calculations have a similar dialog, there is a picture at the top, which shows some sample 
data and where to place the cursors. You can choose the parameters to be exported to the 
Journal in the Parameters to Export list box. The data table shows the calculations for the 
current position of the cursors. The values in the data table are exported to the journal on 
clicking the Add to Journal button.
5 Analysis 62



Spirometry

TV: Tidal Volume

IRV: Inspiratory Reserve Volume

ERV: Expiratory Reserve Volume

FEV1: Forced Expiratory Volume in one second. How much air can be exhaled in the first 
second of expiration

FEV3: Forced Expiratory Volume in three seconds. How much air can be exhaled in the first 
three seconds of expiration

VC: Vital Capacity

PEF: Peak Expiratory Flow

PIF: Peak Inspiratory Flow

TFR:Tidal Flow Rate.

IC: Inspiratory Capacity (IC) = TV + IRV

EC: Expiratory Capacity (EC) = TV + ERV

FRC: Functional Residual Capacity (FRC) = ERV + RV

TLV: Total Lung Capacity (TLC) = TV + RV + IRV + ERV
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ECG

Time at R: Time at the peak of the R-wave.

PR Interval: The time from the beginning of the P wave to the peak of the R wave.

P Duration: Time from the beginning to the end of the P-wave.

QRS Duration: Time from the beginning of the Q wave to the end of the S wave.

QT Interval: Time from the beginning of the Q wave to the end of the T wave.

ST Segment: Time from the end of the S wave to the beginning of the T wave.

T Duration: Time from the beginning to the end of the T wave.

TP Duration: Time from the beginning of the P wave to the end of the T wave.
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Blood Pressure

LVEDP pressure: Left Ventricular End Diastolic Pressure

Time at LVEDP: Time at LVEDP

Max Pressure: Maximum of the pressure, also the systolic value

Time at Max: Time at maximum pressure

Min. Pressure: Minimum pressure, also the diastolic value

Time at min: Time at minimum pressure

Notch Pressure: Pressure at the dichrotic notch

Time at Notch: Time at the dichrotic notch

Max dP/dT: Max slope

Time at Max dP/dT: Time at max slope

Min dP/dT: Minimum slope

Time at Min dP/dT: Time at minimum slope

Mean Pressure: Mean pressure

Contractility Index: (Maximum Slope)/(Pressure at Max Slope)

Systolic Duration: Time from LVEDP to minimum slope

Diastolic Duration: Time from the minimum slope to the next LVEDP
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Cycle Duration: Time between LVEDPs 

Relaxation Index: (Minimum Slope) / (Pressure at Minimum Slope)

Tau (Mirsky): Time for pressure to drop to half its value from the value at minimum slope

Peak Analysis

Max: Maximum amplitude

Min: Minimum amplitude

Max-Min: Maximum amplitude - Minimum amplitude

Mid Amp.: Amplitude at the midpoint of the middle threshold 

Low Width: Width of the peak as measures at the lower threshold

Mid Width: Width of the peak as measures at the middle threshold

Top Width: Width of the peak as measures at the upper threshold

Latency: Time from when the peak leaves the baseline to the peak

Rise Time: Time for the signal to travel from the lower threshold to the upper threshold

Fall Time: Time for the signal to travel from the upper threshold to the lower threshold

Leading Slope: Average slope of the signal as it travels from the lower threshold to the upper 
threshold
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Trailing Slope: Average slope of the signal as it travels from the upper threshold to the lower 
threshold

Max Slope: Maximum slope

Min Slope: Minimum slope

T @Max Slope: Time at maximum slope

T @Min Slope: Time at minimum slope

Copy, Export, 
and Print 
Analysis 
Window

To copy the view of data displayed in the Analysis window, use the Copy command in the 
Edit menu. The image can be pasted into any program (including the Journal) that supports the 
clipboard. To copy a Channel, click the Channel menu and choose the Copy Graph menu. 

To export the data viewed, use the Export command in the File menu. Select the format of the 
file from the list at the bottom of the Export File window.

To print the data viewed, use the Print command in the File menu.

Analyses of the Third Kind: Redisplayed Data
As covered in the display section of this manual, data is recorded only into the Main window. 

Main window displays are linear or in series, meaning that Y-value parameters are recorded with 
respect to time.

Data recorded in a linear manner can be redisplayed in a format that is different than the 
standard Y-T plot. Currently, DataTrax2 supports XY plots and FFT. A host of measurements, 
like the ones available in the Second Kind Analyses, can be made from each type of redis-
played data window.

XY Plot In an XY plot, the Y-values from one channel in the Main window are plotted against the Y-
values from another Main window channel. The resulting XY plot is dramatically different from a 
linear plot of data against time. 
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XY View 
Window 
Components

Selecting Channels To plot an XY graph, select the X-axis channel from the drop-down box in the top most plot. 
Then select the Y-axis channel from the drop-down box in the second plot. If required you can 
also select a marker channel, to highlight certain points of interest. 

Once the channels are selected, the XY plot will be displayed. All the data visible in the X and 
Y axis plots will be included in the XY plot. To select the region of data to be included in the XY-
Plot, select 2 Cursors from the toolbar and bracket the region of interest between the two 
cursors in the X-axis or the Y-axis channel. Next, select Zoom Between Cursors from the 
toolbar.

Functions List The functions selected in the Add Function list determine the calculations performed on the 
data points between the two cursors in the XY-PLot. The results of the selected calculations are 
displayed above the XY PLot .
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Table 
Functions 

These functions are available in the XY window.

General Y1: Value of Y-Axis Channel at Cursor 1.

Y2: Value of Y-Axis Channel at Cursor 2.

X1: Value of X-Axis Channel at Cursor 1.

X2: Value of X-Axis Channel at Cursor 2.

Y2-Y1: The difference in value of Y-Axis channel between the cursors.

X2-X1: The difference in value of X-Axis channel between the cursors.

MaxY: Maximum value of Y-Axis channel between the cursors.

MinY: Minimum value of Y-Axis channel between the cursors.

MeanY: Mean or Average value of Y-Axis channel between the cursors.

MaxY-MinY: Difference between the maximum and minimum values of Y-Axis channel between 
the cursors

MaxX: Maximum value of X-Axis channel between the cursors.

MinX: Minimum value of X-Axis channel between the cursors.

MeanX: Mean or Average value of X-Axis channel between the cursors.

MaxX-MinX: Difference between the maximum and minimum values of X-Axis channel 
between the cursors.

Length: Length of the line segment in the XY-plot between the two cursors.

Derivative dY1/dx: Slope of the XY-Plot at Cursor 1.

dY2/dx: Slope of the XY-Plot Cursor2.

Max dV/dt: Maximum slope of the XY-Plot between the two cursors.

Min dV/dt: Minimum slope of the XY-Plot between the two cursors.

Mean dV/dt: Mean slope of the XY-Plot between the two cursors. This is also the slope of the 
line of best fit for all the data points between the cursors.

Integral (Area) All the integral and area functions are calculated as integrals. 

Area wrt Ymin: The minimum value of the Y channel is taken as baseline and the area of all 
points between the two cursors is calculated with respect to this baseline. 

Area wrt Zero: Zero is taken as baseline and the area of all points between the two cursors is 
calculated with respect to this baseline. 

Area wrt Y1: The value of the Y channel at cursor1 is taken as baseline and the area of all 
points between the two cursors is calculated with respect to this baseline.

Area Loop: The area of the loop as defined by the position of two cursors is calculated.
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Channel Menu in 
the XY Window

Clicking on the Channel Menu button or right-clicking in the display 
area brings up the Channel menu. 

Add Ch. Data to Journal: Adds data from the selected channel to 
the Journal.

Add Title to Journal: Adds the function titles to the Journal.

Invert: Inverts the channel data.

Copy Graph: Copies the channel graph to the clipboard. This can be 
then pasted into the Journal or any other program.

Marker Channel The marker channel is used to mark specific points of interest in the XY-Plot. The marker 
channel is independent of the X and the Y channels, and should be setup in the Main window 
such that the peaks in the marker channel correspond to the points of interest.

When a marker channel is used, data from the XY plot is extracted at the specified points of 
interest and displayed in the Marker Data window. This data can be copied or exported by 
clicking on Options.

Copy, Export, 
and Print XY 
View Window

To copy the view of the data displayed in the XY window, use the Copy command in the Edit 
menu. The image can be pasted into any program (including the Journal) that supports the 
clipboard. 

To export the data viewed, use the Export command in the File menu. Select the format of the 
file from the list at the bottom of the Export File window.

To print the data viewed, use the Print command in the File menu. The print range, which is 
either the selection in the XY window or all the data, can be selected in the Print window

FFT FFT is short for Fast Fourier Transform, a mathematical operation that displays recorded data 
as the relative amplitudes of the frequency components that make up the recorded signal. FFT 
plots have Frequency on the X-axis and the Power (amplitude) contained in each frequency on 
the Y-axis. FFT is used to determine the relative strengths of frequency components in a raw 
signal. For example, in the EEG studies, the Alpha band is frequently mentioned. Alpha waves 
are EEG signals with frequencies between 8 and 13 Hz. If a FFT is performed on an EEG 
recording that has a high number of Alpha waves, the FFT will show a spike or a higher 
amplitude (Power) at the frequencies in the Alpha band. 

The DataTrax2 software can perform Fast Fourier Transforms on selected pieces of recorded 
data in the FFT window. The FFT window is called either from the Windows menu or by clicking 
the FFT icon on the toolbar at the top of the Main window. The selected data is moved to the 
Linear Display area in the FFT window where adjustments can be made which optimize the size 
of the FFT plot. 

To ensure problem-free operation of the FFT function, there are a couple of rules to keep in 
mind:

1 1. The mathematical underpinnings of digital sampling, which makes the DataTrax2 software work, 
begin with a criteria known as the Nyquist Sampling Theorem. Harry Nyquist showed that the sampling 
rate must be at least twice the highest frequency in the sample to reconstruct the original signal and 
capture its fundamental frequency. The converse of this rule is that the fastest frequency that can be 
reliably recorded is a half of the sampling rate. If a recording was made at 1000 samples per second, 
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the maximum frequency that could be recorded reliably would be 500Hz. If a recording was made at 100 
samples per second, the maximum frequency that could be recorded reliably would be 50Hz. When a 
FFT is performed on data recorded with DataTrax2, the program sets the X-axis to a scale from 0Hz 
(DC) to a frequency that is a half of the sampling rate. A region of the scale can be expanded by using 
the cursors and the functions of the Channel menu, but frequencies greater than half the sampling rate 
cannot be viewed.

2 To make an FFT work, the transform must operate on a specific number of data points. The number of 
data points used in the FFT is algorithm dependent. By default The Snap to Grid option is selected, 
which sets the second cursor to the location of the best selection of FFT data on the linear display 
section of the FFT window. If you have to select a different selection, DataTrax2 will fill in the remaining 
data points with zeros so the frequency content of the data that you did select will not be affected. 

As stated in the first rule that governs FFT functions, DataTrax2 sets the X-axis limits in the 
FFT window according to sample rate. Likewise, the number of data points used in the FFT 
calculation sets the resolution of the X-axis range. If more data points are used, the available 
Frequency Resolution will be greater. Frequency Resolution is set from the drop-down menu 
in the left hand margin of the FFT window. Resolution choices are limited to 100 Hz, 10 Hz, 1 Hz 
and 0.1 Hz. If the FFT cannot be displayed with the required frequency resolution, more data 
points need to be used to make the calculation.

Moving and 
Manipulating 
Data in the FFT 
Window

As with other analysis functions handled by the DataTrax2 program, it is necessary to select 
the data to be operated upon by the program. The Display Time controls are used to get the 
data of interest onto a single screen in the Main window. The selected data is moved to the FFT 
window by clicking the FFT icon on the DataTrax2 toolbar or by selecting FFT from the 
Windows menu.

Once the primary data set is moved to the FFT window, the Dual Cursors on the linear graph 
of the raw data (above the actual FFT display area) can be used to fine-tune the data selection. 
Only the data between the cursors in the linear graph is actually used in the calculation. The 
data displayed on the linear graph and available for the transform can be changed using the 
Display Time icons on the FFT window or the scroll bar under the linear graph. As mentioned, if 
Snap To Grid is selected, the DataTrax2 program selects the end point for the data selection.

The FFT plot of the selected data is displayed in the area below the linear graph of the raw 
data. The FFT display area has its own Display controls with the Zoom In, AutoScale and 
Zoom Out functions and set of 2 Cursors. These features can be used to expand or contract 
the area of the FFT graph between the cursors. This set of 2 Cursors also reports the values for 
the selected Table Functions listed above the FFT window. The values and the titles, which are 
listed in the Calculated Value Display area at the top of the window, can be copied to the 
Journal by using the functions in the channel menu for the FFT display area. 

FFT Window 
Components
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 Figure 5-8:FFT Window

Display Channel Located in the upper left of the channel display area, this drop-down box allows the user to 
select the channel to be used in the FFT plot.

FFT Functions 
List

The calculations to be performed on the region of the FFT plot between the 2 Cursors are 
selected from the Add Functions button on the top left of the FFT display area. The results of 
the selected calculations are displayed in the Calculated Value Display area at the top of the 
FFT window. 

Display Controls The FFT plot has display controls similar to the Main window such as Half Display Time, 
Zoom between Cursors and Double Display Time. The Y-axis can be scaled using the 
ZoomIn, AutoScale and ZoomOut buttons in the FFT area toolbar. The frequency resolution 
drop-down box allows setting the frequency resolution of the FFT from 10Hz to 0.01Hz.
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Table 
Functions 

These functions are available in the FFT window.

General Power1: Power at Cursor 1

Power2: Power at Cursor 2

Freq1: Frequency at Cursor 1

Freq2: Frequency at Cursor 2

P2-P1: Difference in power between the cursors

F2-F1: Difference in frequency between the cursors

Max power: Maximum power between the cursors

Min power: Minimum power between the cursors

Mean power: Mean power between the cursors

MaxP-MinP: (Maximum power - Minimum Power) between the cursors

Freq at Max power: Frequency at maximum power between the cursors

Freq at Min power: Frequency at minimum power between the cursors

Integral Power between Cursors: Total power between the cursors 

Channel Menu in 
the FFT Plot

Click the Channel menu to bring up a menu like the one in Figure 5-9 on page 73. 

Selecting Add Title to Journal sends the names of the 
analyses (calculations) being performed and displayed in the 
Calculated Value Display area at the top of the FFT window, 
to the Journal. Selecting Add Data to Journal sends the 
values for these calculations to the Journal. Selecting Copy 
Graph sends an image of the FFT window to the clipboard.

 Figure 5-9: FFT channel menu

Copy, Export, 
and Print FFT 
Windows

Use the Copy command in the Edit menu to copy the view of data displayed in the FFT 
window. This image can be pasted into any program, (including the Journal) that supports the 
clipboard. 

To export the data viewed, use the Export command in the File menu. Select the format of the 
exported file from the list at the bottom of the Export File window.

To print the data viewed, use the Print command in the File menu. The print range, which is 
either the selection in the FFT window or all the data, can be selected in the Print window.
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Analyses of the Fourth Kind: Detected Data Conditions
DataTrax2 software can be used to identify Regions Of Interest (ROI) in recorded data. The 

identified data points can be sent to either the Journal or the Marks window, where they can be 
used to either build a report or be exported. While identifying data does not constitute an 
analysis per se, the detection of specific data always precedes analysis. For example, to 
measure changes in Left Ventricular End Diastolic Pressure (LVEDP) over time, the LVEDP 
points need to be located in the field of blood pressure data and the corresponding values need 
to be recorded. The statistical manipulation of the recorded LVEDP values is classified as 
analysis; but, the first critical step in the “analysis” was the extraction of the relevant data points 
or regions of interest from the complete data. The events (data points or regions of interest) that 
can be detected by the DataTrax2 program are classified into two categories: General and 
Specific.

General 
Events

General events can be located easily through the Find or the Auto Find dialog windows.

Find Dialog 
Window

The Find dialog window is accessed by selecting Find from the Tools menu. Data points of 
interest can be identified using stock commands from the Find dialog window. These commands 
can move cursors to: the Previous or Next Maximum; the Previous or Next Minimum; the 
Previous or Next, Pos or Neg threshold crossing; Data Above or Below a certain amplitude; 
data at a specific Mark with a particular string in a comment; data at an Old or New Cursor 
position; and more. The calculations to be performed on the selected data points or on the data 
between the points are chosen from the Table Functions list before the Find dialog window is 
opened. 

The first step in the Find function is the selection of the Cursor 1 Position from the box to the 
right of this label. The next step in the Find function is the selection of the Cursor 2 Position 
from the box to the right of this label. Once the source of the data is selected and the Find 
routine is completed, it can be saved by clicking the Save button on the Find dialog window. 
The named routine is saved in the Auto Find folder as an .iwxfind file. When the Find dialog 
window is open, saved routines can be recalled by clicking on the Load button.

Find Example As an example, the Find function could be used to determine the time (T2-T1) between two 
events. Occasionally, R waves in an ECG have significantly higher amplitudes than the other R 
waves in the same recording. The Find function could be used to measure the time between 
adjacent supranormal R waves. The process would include:

• Transferring the data of interest from the Main window to the Analysis window. 

• Selecting the calculations ( V1, V2, V2-V1) to be performed on the data from the Table Functions list. 

• Placing one of the 2 Cursors on a supranormal R wave on the left side of the Analysis window.

• Pulling down the Tools menu and selecting the Find function.

• Programming the cursor positions. To find the next supranormal R wave in the data, the Cursor 1 
Position is set equal to Old Cursor 1 (which is already on a supranormal R wave). The Cursor 2 Position 
is set to Data Above and the data channel is selected. The threshold amplitude, above which the Find 
function will stop, is entered into the box below the label Cursor 2 Position. Then the Find routine is 
saved.

• Clicking the Find button to place the cursors and to display the values for the selected Table Functions 
at the top of the Analysis window. 
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• Copying values and their headings to the Journal via the Add Title to Jrnl and Add Data to Jrnl 
functions in the Right-Click menu of the Analysis window.

Auto Find Dialog 
Window

The Auto Find dialog window (Figure 5-10 on page 75) is like the Find window. It is also 
accessible from the Tools menu and works only from the Analysis or ScopeView window. 
However, the Auto Find function can be programmed to find multiple data points with the same 
parameters within a data selection. The values at those points can be used for Second Kind 
Analyses and the results of these analyses can be written to the Journal automatically. 

The Auto Find function can find the same types of data points found with the Find function, 
like: Next Maximum, Previous Minimum, Data Above a given value, the next Mark containing 
a particular alpha-numeric string, and more. Like Find routines, Auto Find routines may be 
constructed from the various parameters available and saved in the Auto Find folder. For 
periodic functions, maximum values, and minimum values, DataTrax2 uses the threshold values 
set for Periodic data on the Functions page in the Preferences dialog window for the Main 
window. Just like other measurements of periodic data, the data must be scaled properly, which 
can be accomplished in most cases by clicking the AutoScale button in the Main window.

Auto Find 
Example

As an example, the Auto Find routine can be used to place cursors on all the R waves in an 
ECG record and to measure the period (T2-T1) of each beat. The easiest way to begin the Auto 
Find routine is to manually place the cursors on the two successive R waves at the beginning of 
the record. When selecting the commands to use in this routine, the user should ask 
themselves: “Where are the next two data points that are needed for measuring the next period 
(T2-T1)?” The answer is that the first data point in the next period is the second R wave from the 
preceding period, and the second R wave in the next period is the next maximum value or R 
wave in succession. Therefore, to make accurate measurements on the next period, the Auto 
Find window is programmed to set the Cursor 1 Position to be Old Cursor 2 and the Cursor 2 
Position to be the Next Max. 

 Figure 5-10: The Auto Find dialog window.
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After the number of repetitions specified or the specified end of the Auto Find routine is 
reached, the Auto Find routine can be saved by clicking Save on the dialog window. The named 
Auto Find routines are saved as .iwxfind files and can be called by clicking on the Load button 
in the dialog window.

Specific 
Events

The detection of Specific events within a recording requires the use of an algorithm to find the 
point or region of interest (ROI). The LVEDP, the R in an ECG, and the P wave in an ECG are 
good examples of Specific events. Detection of these data points requires a defined software 
routine that resides in the DataTrax2 program. The routines are accessible by selecting Auto 
Mark from the Tools menu and the name of the specific event from the Auto Mark drop-down 
menu. When the detection routine is run on the selected data, the software puts Marks on the 
data at the detected points. The automatic placement of Marks on the data accomplishes two 
things; first, it identifies the data points that need to be manipulated; second, it provides the 
user with visual cues to confirm that the software did the job of detecting the correct points. 
Based on the instructions given to DataTrax2, the detected data can be exported as text or 
loaded into a script. 

In DataTrax2, there are Auto Mark functions available to detect: the components of the ECG, 
the Blood Pressure and Peak Analysis.

ECG For example, if the Auto Mark detector is used to locate the components in an ECG, the ECG 
function is selected from the Auto Mark submenu on the Tools menu. A window known as the 
AutoMark ECG Dialog appears on the screen. It contains a display of the data to be used with 
the marking routine. In this window, selections must be made for the Data Channel that is the 
source of the recording being marked, the Maximum Heart Rate (BPM) in the data of interest, 
and the Start and Stop points for marking the data of interest.

The Start and Stop points could be the beginning and the end of the data file (Doc.), respec-
tively. They could also be any Mark on the data file. Since Marks can be placed on the data 
after the recording, it is possible to place and use Marks that are on the margins of the data of 
interest. To assist in R wave detection, a threshold level must be set on the data.

Finally, press Preview and close the AutoMark QRS Dialog window by clicking OK. Each R 
wave in the selected section of data will be marked with a Text Mark. These marks can be 
viewed and edited in the Marks window. The Marks window is organized so that the marks can 
be sorted by Time (ascending or descending), Channel, or by Content by clicking on the title of 
the column in the Marks table. Individual comments, or ranges of comments, may be selected or 
deselected using the SHIFT and CONTROL keys. Appropriate collections of selected comments 
can be exported or deleted.
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 Figure 5-11: ECG AutoMark Dialog

 Figure 5-12: ECG AutoMark Example
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Blood Pressure

 Figure 5-13:Blood Pressure Automark Dialog

 Figure 5-14: Blood Pressure Automark Example
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Peak Analysis

Analysis of the Fifth Kind: Things Not Possible with 1st, 2nd, 
3rd, or 4th Kinds of Analyses

Not Yet Implemented in DataTrax2:

It is impossible to include all of the possible analyses and plotting capabilities required for 
biological research in a single program. We provide, what we believe to be, useful tools for 
completing the most common kinds of analyses. For circumstances where the built-in analysis 
tools fall short of the user’s requirements, DataTrax2 has a Script function. A script is a 
program, written in any of the languages supported by DataTrax2, that can perform a series of 
calculations on selected data. Once created, a script can be placed in the Scripts folder located 
in the DataTrax2 folder. The script will then appear as a menu item in the DataTrax2 Scripting 
menu. When selected, the script takes the selected range of recorded data, saves the data in a 
format compatible with the scripting language, loads the scripting program, and then executes 
the script on the saved data. The scripting programs supported by DataTrax2 are listed below. 
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For example, we have created a script in Python, which operates on the R-R intervals of the 
ECG, which are detected by an Auto Mark function in the Tools menu. Then the R-R script 
computes and displays a tachogram, plots Delta R-R histograms and determines values for 
statistics, such as mean, mode, and standard deviation. 

Writing 
Scripts

DataTrax2 has a special folder called Scripts located in the DataTrax2 folder. Any scripting 
files or executables placed in this folder will be included in the Scripting menu when DataTrax2 
is launched.

Scripts can be run from the Main, Analysis, or ScopeView windows in the DataTrax2 
program. Different data is presented to the script depending on which window is used to call the 
script. 

The Default Export File Format, for exporting the data that the script will use, is set on the 
Advanced page of the Preferences dialog window. The default file format is .mat, or the Matlab 
File format. For information about the MatLab and DADiSP file formats, refer to the Export 
section of this manual.

Scripts in the Main 
Window  

When a script is run from the Main window, DataTrax2 saves the complete data file in the 
Scripts folder as either input.mat (Matlab) or inputXX.dat (DADiSP). In DADiSP, each block is 
numbered as it is saved XX, starting with 00. When DataTrax2 calls the script file, the Windows 
operating system opens the script file in the program associated with it. For example, a Python 
script should open in the Python program and a MatLab script will open in the MatLab program 
and so on. Scripts should be set up to open and analyze data files with the names as described. 

Scripts in the 
Analysis Window  

When a script is run from the Analysis window, DataTrax2 saves the data in the Analysis 
window display in the Scripts folder as either input.mat (Matlab) or input.dat (DADiSP). When 
DataTrax2 calls the script file, the Windows operating system opens the script file in the 
program associated with it. For example, a Python script should open in the Python program, 
and a MatLab script will open in the MatLab program and so on. Scripts should be set up to 
open and analyze data files with the names as described. 

Scripts in the 
ScopeView 
Window  

When a script is run from the ScopeView window, DataTrax2 saves the data in the 
ScopeView window display in the Scripts folder as either input.mat (Matlab) or input.dat 
(DADiSP). When DataTrax2 calls the script file, the Windows operating system opens the script 
file in the program associated with it. For example, a Python script should open in the Python 
program and a MatLab script will open in the MatLab program and so on. Scripts should be set 
up to open and analyze data files with the names as described. 
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Chapter 6: Input and Output 

Stimulator
The Stimulator page in the Preferences dialog box controls the Digital-to-Analog Converter 

or DAC of the WPI hardware. It can be reached by selecting Preferences from the Edit menu. 
The stimulator feature sends the DAC output to the outside world. Using controls described 
below, output protocols can be built from “square wave” components that are listed on the 
Simulator page of the Preferences dialog window. The available output range of the stimulator 
is ±5V for the WPI 214 and ±10V for WPI 118 and 3xx.

The WPI 118 has two DACs, while the 3xx has a DAC on each 
channel. Each DAC can be controlled independently. The stimu-
lator drop-down box (currently set to Stim1) allows selection of 
the stimulator to be setup. For devices with multiple stimulators, 
the import Settings button allows the user to copy settings from 
one stimulator to another. 

Six modes of output, Pulse, Trains, Constant (voltage), Step, 
Triangle and Ramp, can be selected using the mode drop-down 
box (currently set to Off). Triangle and Ramp protocols are 
available only on the WPI 3xx. 

The Bipolar checkbox allows the creation of bipolar pulses.

The stimulator can be set to fire when the recording is started by 
checking the Start Stimulator with Recording checkbox.

Time Resolution: The WPI 3xx has three time resolutions, 0.04ms, 0.4ms and 4 ms. The finer 
the time resolution the shorter the maximum time duration for each parameter. For example, at 
0.04msec Time Resolution the maximum delay is 600 ms. At 0.4ms this increases to six 
seconds, while at the 4msec resolution the maximum delay is 60 seconds.

The software configures itself depending on the hardware selected and will limit the available 
range of values for each parameter accordingly.

Toolbar Steps: This determines the minimum step increments that the stimulator toolbar will 
use when the up/down buttons on the toolbar are clicked. These are also the increments used 
by sequences for programming the stimulator. 
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Pulse 
Protocols

 Figure 6-1: The parameter boxes on the Stimulator page of the Preferences dialog window.

In order to understand how protocols are created, it is necessary to define the terms used on 
the Stimulator page of the Preferences dialog window:

Delay: This is the time between the beginning of the recording, at the clicking of the Record 
button, and the first pulse. Delay is adjustable as follows:

WPI 118 (6500 ms), WPI Latrax 24 series:(600 ms, 6s or 60 s).

Amplitude: This is the height or voltage of the pulse or wave being generated. The amplitude 
programmed from the Preferences window will be the same for all pulses leaving the stimulus 
output unless the amplitude is changed manually from the Preferences window or the Stimu-
lator Control Panel, or automatically from a programmed sequence (more later).

Number of Pulses: The total number of pulses that can be sent from the stimulator output

Pulse Width: The pulse is the basic unit of an output protocol and it has two basic dimen-
sions, amplitude, as described above, and length. The length of the pulse is also called pulse 
width or pulse duration .

Pulse Frequency: This is the number of programmed pulses that are delivered in one second 
period of time. The maximum frequency that can be set is dependent on the pulse duration. 
Remember that the period (P) is the inverse of the frequency (F), or P = 1/F.

Time Off: This is the interpulse duration, i.e. the amount of time between two consecutive 
pulses. Pulse Frequency is 1/(pulse width + Time Off).
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Holding Potential: This is a voltage between ±10V  that can be programmed to shift the 
resting voltage of an excitable tissue (like a nerve). It is also known as a holding voltage 
because it can be used to hyperpolarize the membrane potential of an excitable tissue and 
prevent it from depolarizing or “firing.”

Building Output 
Protocols in Pulse 
Mode

To record stimulus pulses like the examples that follow, the stimulator output of an WPI unit 
can be connected to one of its own BNC inputs. On the WPI 118, this is easily accomplished by 
using a BNC-BNC cable. However, the stimulator outputs of the WPI 214 unit consists of three 
color-coded banana jacks, so a Double Banana-BNC adapter or cable is needed to connect two 
of the banana jacks to one of the BNC inputs. To record positive pulses, connect the adapter to 
the positive (red) and ground (green) banana jacks; to record negative pulses, connect the 
adapter to the negative (black) and ground (green) banana jacks. Double-Banana adapters have 
a flag or bump on one side that indicates which side should be attached to the ground jack.

Note: Never connect both the positive (red) and the negative (black) banana outputs of a 214 unit to its 
own inputs, as this causes a short circuit that could damage the amplifier. These red and black outputs can 
be connected to other devices (nerve chambers, stimulating electrodes, and more), but not to its own 
inputs.

An Example of 
Continuous Pulses

1 To construct and record some examples of stimulus pulses, select Preferences from the Edit menu. On 
the Channel page of the Preferences dialog window set a channel that has a BNC input to record 
at 10,000 samples/second and display 0.5 seconds on the screen. Also select the Stim1 channel and 
set it to record the stimulator. (Figure 6-2 on page 83). 

 Figure 6-2: Channels page of the Preferences dialog window set for the pulse mode example.

2 Go to the Stimulator page of the Preferences dialog window; select Pulses from the box in 
the upper left corner of the page.

3 Enter the following values into the appropriate boxes on the Stimulator page:

Delay 100msec (an arbitrary value)
Amplitude 1V 
Number of Pulses 0 (for continuous)
Pulse Width 5ms
Pulse Frequency 100 Hz
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Holding Potential 0 V

These settings will create a protocol that delivers continuous square waves with 1V amplitude 
and 100Hz frequency. 

4 Press the Record button. The DAC will wait 100 milliseconds (the Delay value entered) and begin to 
deliver 5ms pulses at the rate of 100 pulses per second. Each pulse will be 1V high. These pulse 
parameters can be adjusted in any way with one exception, the pulse width cannot be longer than the 
inverse of the frequency (or the period). In this example, the 100Hz square wave delivers 100 events or 
pulses every second. Therefore, each single event or pulse must occur in 1/100th of a second, which is 
a 10ms period. In this example, the pulse width cannot be longer than the period of 10ms or the pulse 
will overlap the next pulse. The percentage of the period occupied by the pulse width is known as the 
duty cycle and refers to the amount of time the output amplifiers are active.

An Example of a 
Burst of Pulses

Use the settings listed for the example of continuous pulses to produce a short burst of pulses, 
with one exception. Set the Number of Pulses to a number other than zero. If the number 10 is 
entered in this box, the output from the DAC would wait the 100 millisecond delay from the Start 
signal, deliver its 100Hz square wave of 5ms by 1V pulses as before, but stop when 10 pulses 
had been delivered. A graphical representation of the two examples above is pictured in Figure 
6-3 on page 84.

 Figure 6-3: Continuous (top) and burst (bottom) of pulses that are the same amplitude, width, and frequency.

Train 
Protocol

A train of pulses is more properly called a burst of pulses. Trains contain a specified Number 
of Pulses, which occur a specified number of times (Number of Trains) at regular intervals 
(InterTrain Duration). The train protocol is an extension of the pulse protocol so it is essential 
to be familiar with the pulse protocol to use the train protocol. 

Continuous output

Burst or Train output
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 Figure 6-4: The parameter boxes on the Stimulator page for Train mode.

The terms used on the Stimulator page of the Preferences dialog window for configuring 
trains of pulses, include:

Delay: This is the time between the beginning of the recording, at the clicking of the Record 
button and the first pulse. Delay is adjustable as follows:

WPI 214 (650ms), WPI 118 (6500 ms), WPI 3xx:(600 ms, 6s or 60 s)

Amplitude: This is the height or voltage of the pulse or wave being generated. The amplitude 
programmed from the Preferences window will be the same for all pulses leaving the stimulus 
output unless the amplitude is changed manually from the Preferences window or the Stimu-
lator Control Panel, or automatically from a programmed sequence (more later)

Number of Pulses: The total number of pulses that can be sent from the stimulator output

Pulse Width: The pulse is the basic unit of an output protocol and it has two basic dimen-
sions, amplitude, as described above, and length. The length of the pulse is also called pulse 
width or pulse duration

Pulse Frequency: This is the number of programmed pulses that are delivered in a one 
second period of time. The maximum frequency that can be set is dependent on the pulse 
duration. Remember that the period (P) is the inverse of the frequency (F), or P = 1/F

Time Off: This is the interpulse duration, i.e. the amount of time between two consecutive 
pulses. Pulse Frequency is 1/(pulse width + Time Off)

Number of Trains: Number of Trains 

InterTrain Duration: The length of time between successive trains or bursts
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Holding Potential: This is a voltage between ±10V that can be programmed to shift the 
resting voltage of an excitable tissue (like a nerve). It is also known as a holding voltage 
because it can be used to hyper polarize the membrane potential of an excitable tissue and 
prevent it from depolarizing or “firing.”

Building Output 
Protocols in Train 
Mode

Connect the stimulus outputs to one of its own BNC inputs as described in the Building 
Output Protocols in Pulse Mode section of this chapter.

Note: Never connect both the positive (red) and the negative (black) banana outputs of a 214 unit to its 
own inputs, as this causes a short circuit that could damage the amplifier. These red and black outputs can 
be connected to other devices (nerve chambers, stimulating electrodes, and more), but not to its own 
inputs.

In many applications, more than one burst or train of pulses must be delivered. Before the 
parameters of the trains or bursts are specified, the dimensions of the pulses that will fill the 
bursts must be selected. After the pulse is designed, the frequency, duration, and number of 
trains can be programmed.

An Example of 
Pulse Trains

1 To construct and record an example of pulse trains, select Preferences from the Edit menu. On the 
Channels page of the Preferences dialog window set a channel that has a BNC input to record at 
10,000 samples/second and display 0.5 second on the screen (Figure 6-2 on page 83). 

2 Go to the Stimulator page of the Preferences dialog window; select Trains from the box in 
the upper left corner of the page.

3 Enter the following values into the appropriate boxes on the Stimulator page:

Delay 100msec (an arbitrary value)
Amplitude 1V 
Number of Pulses 10 (10 pulses at 100 Hz = 0.1 sec)
Pulse Width 5ms
Pulse Frequency 100 Hz
Number of Trains 25
InterTrain Duration 900ms

These settings will create a protocol that delivers: a train of pulses every second; 10 pulses in 
each train with a frequency of 100 Hz; and, all pulses with an amplitude of 1V and a width of 
5msec. Since a train occurs every second and is 100msec long, the time between trains, the 
InterTrain Duration, needs to be 900msec.

4 Press the Record button. The DAC will wait 100 milliseconds (the delay value entered) and begin to 
deliver ten 5ms pulses in a tenth of second. Each pulse will be 1V high. After 900 milliseconds, a 
second burst of ten pulses with the same parameters will occur. These bursts will appear in this manner 
until a total of 25 bursts have occurred. 

5 If you only wanted the train or burst to repeat four times, the number four should be entered in the 
Number of Trains box. The completed output protocol should look something like Figure 6-5 on page 
87.
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 Figure 6-5: Burst of pulses separated by Inter Train Durations.

Constant 
Voltage 
Protocol

Selecting the Constant (voltage) option on the Stimulator page of the Preferences dialog 
window disables the entry boxes for all stimulus parameters except Amplitude and Delay. When 
the Record button is clicked, the voltage set on the Stimulator page is delivered to the low 
voltage output of the WPI unit. The voltage output terminates when the recording is stopped.

Step Mode Step mode is used almost exclusively for voltage clamp protocols. In Step mode, the 
amplitude of stimulator output can be increased or decreased in a step-wise manner, and the 
user can specify the following parameters: Delay, Start Amplitude, Stop Amplitude, Number 
of Steps, Step Width, Time off (or Inter Step Width), Repeat Count, Interprotocol Duration 
and Holding Potential

 Figure 6-6: The parameter boxes on the Stimulator page set for Step mode.

Building Output 
Protocols in Step 
Mode

The amplitude of each individual step in the protocol is determined by the DataTrax2 program 
with the Starting and Ending Amplitudes and the Number of Steps entered on the Stimulator 
page. The equation used to do this calculation is: 

(Start Amplitude - End Amplitude) = Voltage Increment
 Number of Steps
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If the user knows the voltage increment needed at each step, the equation can be transposed 
to solve for the Number of Steps required in the protocol and this value can be entered on the 
Stimulator page:

(Start Amplitude - End Amplitude) = Number of Steps.
Voltage Increment

Likewise, if the user knows the previous amplitude and the voltage increment, the succeeding 
amplitude can be calculated:

Previous Amplitude + Voltage Increment = Succeeding Amplitude

With the starting, ending and incremental voltages set through Preferences, the voltage will 
change in a step wise manner until the ending voltage is reached. The length of the protocol is 
determined by the Step Width and the time between steps, the Time Off.

Repeat Count: The number of times the above step protocol will repeat

Interprotocol duration: The duration of time between the termination of one protocol and the 
initiation of the next protocol

An Example of 
Voltage Steps

1 To construct and record an example of pulses in Step mode, select Preferences from the Edit menu. 
On the Channels page of the Preferences dialog window set a channel that has a BNC input to 
record at 10,000 samples/second and display 0.5 second on the screen (Figure 6-2 on page 83). 

2 Go to the Stimulator page of the Preferences dialog window; select Step from the box in the upper left 
corner of the page. 

3 Enter the following values into the appropriate boxes on the Stimulator page:

Delay 0
Starting Amplitude  -1V
Ending Amplitude +1V
Number of Steps 8
Step Width 100 ms
Time Off 0
Repeat Count 1
Interprotocol duration 0
Holding Potential 0

4 These settings will create a wave form that starts at -1 Volt and climbs to +1 Volt in eight steps, each 
step has a voltage increment of 0.25V and 100ms wide.

5 Press the Start button. The resulting wave would be similar to the step-wise elevation of 
output amplitude seen in Figure 6-7 on page 88. 

 Figure 6-7: An example of a continuous step protocol.
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6 To create a step protocol where the voltage returns to a baseline value between steps, alter 
the Time Off to a number greater than zero. The resulting wave would be similar to that seen 
in Figure 6-8 on page 89.

 Figure 6-8: An example of a step protocol punctuated by returns to baseline between steps.

7 A Constant voltage protocol can be combined with the Step protocol to have the voltage return to a 
different baseline after the completion of the step sequence. For example, setting the Holding Potential 
in the sample step protocol to 500mV would cause the output amplitude of the stimulator to return to 
500mV at the end of the step sequence. Subsequent firings of the protocol would begin from the new 
baseline of 500mV, drop to the Start Amplitude in the example (-1V), step to the End Amplitude (+1V), 
and then return to the Holding Potential of 500mV.

Ramp 
Protocol

 Figure 6-9: The parameter boxes on the Stimulator page set for Ramp mode

Delay: This is the time between the beginning of the recording, at the clicking of the Record 
button, and the beginning of the ramp
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Delay Amplitude: The amplitude during the delay period. Only available on the WPI 3xx

Start Amplitude: The starting amplitude of the ramp

Stop Amplitude: The ending amplitude of the ramp

Rise Time: The time taken to go from the Start Amplitude to the Stop Amplitude

Num Ramps: Number of Ramps 

Interprotocol Duration: Time between ramps

Holding potential: The amplitude during the interprotocol duration

Triangle 
Protocol

 Figure 6-10: The parameter boxes on the Stimulator page set for Triangle mode

Delay: This is the time between the beginning of the recording, at the clicking of the Record 
button, and the beginning of the triangles

Delay Amplitude: The amplitude during the delay period. Only available on the WPI 3xx

Start Amplitude: The starting amplitude of the triangle

Stop Amplitude: The ending amplitude of the triangle

Rise Time: The time taken to go from the Start Amplitude to the Stop Amplitude

Num Triangles: Number of Triangles 

Interprotocol Duration: Time between triangles
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Holding potential: The amplitude during the interprotocol duration. Should be set to Start 
Amplitude if not being used

The 
Stimulator 
Panel 

Selecting the Stimulator Panel item in the View menu (Figure 6-11 on page 91) will place a 
Stimulator Control Panel (Figure 6-12 on page 91) on the Main window.

The Stimulator Panel can be used to create a new protocol or change 
the parameters for an existing protocol

Each stimulator mode has a unique toolbar as shown below.

 Figure 6-11: The View menu.

Pulse Mode

 Figure 6-12: The Stimulator Pulse Control Panel.

Amp: Amplitude of the stimulus pulse in Volts

#pulses: Number of Pulses

Width(ms): Width of the pulse in milliseconds (ms)

F(Hz): Frequency of stimulation in Hertz (Hz)

HP: Holding potential

Apply: applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output

Train Mode

 Figure 6-13: The Stimulator Train Control Panel.

Amp: Amplitude of the stimulus pulse in Volts

#p: Number of Pulses

W(ms): Width of the pulse in milliseconds (ms)

F(Hz): Frequency of stimulation in Hertz (Hz)

#R: Number of Trains (or Repeat Count)

IP Dur: InterTrain(or inter protocol) duration

HP: Holding Potential

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output
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Step Mode

 Figure 6-14: The Stimulator Step Control Panel.

A1: Starting Amplitude

A2: Stopping Amplitude.

#steps: Number of Steps

W(ms): Width of the step in milliseconds (ms)

F(Hz): Frequency of stimulation in Hertz (Hz)

#R: Repeat Count

IP Dur: Inter protocol duration

HP: Holding Potential

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output 

Constant Mode

 Figure 6-15: The Stimulator Constant Control Panel.

Amplitude: Amplitude.

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will set the amplitude at the output.

Ramp Mode

 Figure 6-16: The Stimulator Step Control Panel.

A1: Starting Amplitude

A2: Stopping Amplitude

Rise time: The time taken to go from the Start Amplitude to the Stop Amplitude

Num Ramps: Number of Ramps

IR: Time between Ramps

HP: Holding potential

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output

Triangle Mode

 Figure 6-17: The Stimulator Step Control Panel.

A1: Starting Amplitude

A2: Stopping Amplitude
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Rise time: The time taken to go from the Start Amplitude to the Stop Amplitude

# Triangles: Number of Triangles

IR: Time between Triangles

HP: Holding potential

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output

Note: The Stimulator preferences dialog will draw whatever protocol you specify. Be sure to examine the 
output representation carefully before closing the dialog to confirm that this is in fact the output that you 
want.

Stimulator 
Display

On WPI 214/118/3xx, the stimulator output can be displayed as a channel in the Main window. 

Stimulus 
Protocols 
Built with the 
Sequence 
Builder

Experiments are often designed to record the response of a cell (or a tissue) to progressively 
larger or more frequent stimuli. In these cases, parameters of the stimulus are changed before 
each recording of the cell’s response to the next stimulus. The Sequence Builder, a page in the 
Preferences dialog window, can be used to automatically change parameters of the stimuli 
released from the DAC. 

For example, excitable tissues like nerves and muscles are composed of multiple fibers, each 
with a different diameter, conduction velocity and threshold. Fibers with higher thresholds 
require a larger stimuli to evoke their action potentials. Increasing the amplitude of the stimulus 
sent to the excitable tissue will cause more fibers in the tissue to fire. This is known as 
recruitment and is measured as an increase in the amplitude of the tissue’s compound action 
potential. 

In Scope mode, the Sequence Builder and other pages (Channels, Stimulator) in the 
Preferences dialog window can be used to record each response of the excitable tissue to a 
stimulus and automatically increase the amplitude of the stimulus between each trial.

Channels Page To construct an example of an Sequence designed to control the DAC and to record in Scope 
mode, select Preferences from the Edit menu. On the Channel page of the Preferences dialog 
window set:

Acquisition Mode Scope: Multiple
Number of Sweeps 10
Delay Between Sweeps 2
Start User
Stop Timed: 0.03 sec
Sampling Speed 20000
Display Time 0.030 sec
Select A1  Raw Channel 1: set Mode to BNC
Deselect A2-A4 i.e. raw channels 2, 3 and 4
Select S1  stim 1: Set Mode to Record.
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 Figure 6-18: Channels page of the Preferences dialog window set for testing an Output Sequence.

Stimulator Page

 Figure 6-19: Stimulator page of the Preferences dialog window set for testing an Output Sequence.
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On the Stimulator page, select Pulses as the stimulating mode and set the parameters.

• Toolbar Steps

Freq (Hz) = 1; Amp (V) = 0.05; Time (ms) = 0.1.

• Initial Parameters

Delay 5 ms

Amplitude 0.25 V

Number of Pulses 1

Pulse Width 0.1 s

Time Off 0.1 s

Holding Voltage 0 V

Sequence Page

 Figure 6-20: Output sequences page of the Preferences dialog window.

1 On the Sequences page, add a CAPRecruit sequence to the list of current sequences. Type the name 
CAPRecruit in the Edit box next to the Current Sequence Label, and click the New button.

2 Select the state titled Inc Pulse Amplitude under Stim 1 from the list of states on the left side of the 
page. 

3 Click on the button Add State to Sequence to add the state to the CAPRecruit sequence. 

4 Click OK at the bottom of the page.
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5 Return to the Main window; select the CAPRecruit sequence from Sequences control on the toolbar. 

6 Click the Record button. The program records, displays and saves the ten progressively larger stimulus 
pulses on ten successive Scope sweeps.

7 Click on the Analysis icon in the toolbar to view the sweeps recorded for each stimulus amplitude.

Outputs States

States Output states are used in the construction of sequences. There are six categories of output 
states:

1 General: The general category includes Start Recording, Stop Recording and 
Update.

2Dig. Output: Controls the digital outputs. For each digital output there is an on 
state and an off state. You can also turn all digital outputs on or off simulta-
neously.

3Stim#: Controls the corresponding stimulator parameters. This can be used to 
change the stimulator parameters on the fly.

4Mark: Set Marks in the record.

5Message: Display User Messages on the screen.

6Sound: Plays an existing audio file, located in the same folder as the current 
settings file.

The WPI 118 has up to eight Digital Outputs in two banks. BNC’s 5 -8 can be configured as 
Digital Inputs or as Digital Outputs. Each digital output can be controlled independently.For 
each digital output there are two states, On and Off. So for eight digital outputs we have 16 
states.

Naming States Each output state can be named. To name an output state, click once to select the state, then 
click again to edit the name. Type the new name of the state in the Edit box that appears. If you 
want a mark to be placed on the record when the digital state is fired, double-click the checkbox, 
next to the label, so that a checkmark appears. For example, in the figure below, DO2 On has 
been labeled as Pump On and set to place a mark in the record when it is fired.
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 Figure 6-21: Output States

Sequences Digital states can be grouped together in Sequences. A Sequence allows timed execution of 
digital states. 

Creating Sequences To create a Sequence, type the name of the sequence in the Edit box next to the Current 
Sequence Label and click New. 

Editing a Sequence Select the sequence to be edited in the Current Sequence drop-down box. To add a digital 
state to the sequence, select the digital state from the list on the left side of the window and 
click Add State to Sequence. To remove a state from the sequence, select the state in the 
sequence and click Remove State from Sequence. To have the WPI device wait for a specified 
period of time between different digital states, type a time (in seconds) in the Edit box next to 
the Wait button and click Wait to insert the waiting period into the sequence.

The timing for the digital inputs is handled by the computer and since Windows is not a real-
time operating system, there is an inherent lag in the processing of events. The digital output 
timing should be within one second. To set more than one state at the same time, add all the 
states you want to set simultaneously to the sequence before setting Wait or Update (under 
General). The DataTrax2 program will “OR” all the states and execute them when it reaches the 
Wait statement, the Update statement or the end of the sequence. To repeat the sequence, set 
the repeat count. The order of the states in the sequence can be changed by using the up and 
the down buttons.
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Firing a Sequence The Sequence Control on the Main toolbar is a menu containing 
sequences of analog or digital outputs defined in the Sequence 
page of the Preferences dialog window. Clicking the Sequence 
button will fire the output sequence selected from the list. 
Selecting a new sequence in the list also automatically fires that 
sequence.

Digital Input
The Digital Input function treats the data on the 
selected channel as a binary number.

The functions in the Digital Input submenu are:

Rate: The program takes the period in seconds 
and divides this value into 60. The result is a 
rate, which is expressed in beats per minute

Frequency: The program takes the period in 
seconds and divides this value into 1. The result 

is a frequency, which is expressed in Hz or cycles per second

Period: The program takes the Period for each cycle

Time On: The time that the selected channels are high

Time Off: The time that the selected channels are low

Duty Cycle: 100* (Time On)/Period

Count: Number of events

The channels of interest can be 
selected using the checkboxes. If 
you desire to complement the input 
before it is used then click on the 
checkbox again, as shown in the 
legend.

Reset After n sec: This option is 
only available for the Count 
subfunction, which is used to reset 
the count after n seconds

Any Bit is Set/ All Bits are set: 
Choose if you want an event to be 
detected if any channel is high or if 
you only want an event to be 
detected if all channels are high
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Events
As DataTrax2 acquires data, it is aware of the value of each data point as it happens. It should 

then be possible to "train" the software to watch for values above or below a specified level and 
have DataTrax2 advise the user when such conditions are met. This feature in DataTrax2 is 
called an Event. Events are set up in the events page of the Preferences menu.

 Figure 6-22: Controls for the Event programming 

There are two types of events: Channel events and Timed Events.

Channel Events 1 Data on one channel is monitored.

2 You have to set a threshold_high and a threshold_low value. The threshold values can be set either by 
entering a value or by dragging the cursors in the graph.

3 You can select one of the following triggering options:

•Positive Edge Triggered: The data value has to go from below the threshold_low value to above 
the threshold_high value

•Negative Edge Triggered: The data value has to go from above the threshold_high value to below 
the threshold_low value

•In window: If the data value is between threshold_low and threshold_high value;

•Out of Window: if the data value is outside the window defined by threshold_low and 
threshold_high value
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Timed 
Events

 Timed events are triggered after a certain amount of time has passed. Timed events can be 
repeated, set N = 0 for continuos.

Event Priority Events have priority. Sequences launched by events inherit the priority from that Event. A 
higher priority event can stop a lower priority sequence, but a lower priority event cannot stop a 
higher priority sequence.

User Events (i.e. sequences triggered by user) are also treated as events having a priority of 
50. For example, Events 1 and 2 could have a higher priority than the user, thereby allowing 
them to interrupt a user initiated sequence, while Event 3 with a lower priority than the user, 
cannot interrupt a user initiated sequence.

An event can start in an enabled or disabled state. A disabled event is ignored. Events can 
enable or disable other events. The enabling or disabling function works independent of the 
sequences, so lower priority events can enable or disable events, even when there is a higher 
priority sequence running.

In the example shown Figure 6-22 on page 99, The pulse channel is being monitored for a 
positive threshold crossing from below 0.67804 to 0.900062. The event is enabled, with a 
priority of 50 and set to fire the sequence "Start Pump." This event will also enable “event3” and 
“event4”, while disabling “event2.”
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Chapter 7: Using Settings

The Settings Menu
DataTrax2 offers users several choices for recording and displaying data. When certain 

choices are used repeatedly, a template known as a settings file, can be created to reduce the 
time required to program the recording software and the A/D converter.

To understand how to use settings files, two terms need to be defined: settings group and 
settings file. A settings group is actually a simple text document that can contain links to 
individual settings files. Each settings file is a collection of settings for performing an exper-
iment and is programmed by users through the Preferences dialog window from the Edit menu. 
The settings contained in a file include items like: the number and titles of channels in the 
DataTrax2 windows; the sampling speed; the units conversions; and the stimulator settings.

In addition to the hardware and software provided in its teaching kits, WPI provides laboratory 
manuals with a variety of experiments. To support these experiments, WPI has created a 
settings group for each laboratory manual. Each settings group contains links to settings files 
for each experiment. Settings groups are loaded on the computer during the installation of the 
DataTrax2 recording software. Once a settings group is loaded, the settings files within the 
group can be called from a list in the Settings menu.

Calling a 
Settings File

Before a settings file can be selected 
and activated, the settings group that 
contains the file must be loaded. To do 
this, select Load Group from the 
Settings menu. Choose the settings 
group file, that you wish to load. Settings 
groups associated with WPI manuals are 
saved in the DataTrax2 folder when the 

WPI Laboratory manuals are installed. 

Once a settings group is loaded, all of the settings files contained in the group appear by 
name in the lower bracket of the Settings menu. The settings files in the menu are organized by 
categories. To select a specific settings file, highlight the name of the file and click it. The 
settings associated with the selected file will load into the DataTrax2 program and set param-
eters for recording and displaying data.

For a settings group associated with an WPI teaching kit, the names of the settings files on the 
list correspond to the names of the experiments in the lab manual.

If the WPI laboratory manuals are installed from the installation CD as prescribed, each 
settings file in the settings group for a teaching kit is associated with a helper file, which is a 
.pdf copy of the laboratory exercise as it appears in the WPI laboratory manual. 

Users can design their own settings groups and files. They can also associate their own 
setting files with documentation (experimental procedures, protocols, instructions, lab exercises) 
of their own design. 
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Creating a 
New Settings 
File

The first step in creating a settings group is to create a settings file. Configure the DataTrax2 
program to do the experiment you want to do. For example, go to the Channels page in the 
Preferences dialog window and select the number of channels needed, their titles and any 
Functions that are needed to display or interpret the data. 

You can also assign an aim and a difficulty level to each settings file by using the Document 
Properties command under the File Menu. 

Click on the File menu and choose Save As. A File Save dialog will appear. In the Save As 
Type drop-down box at the bottom of the dialog, choose Settings (*.iwxset). Using the file 
browser, choose a location on your computer where you want to save the settings file. We 
recommend that you create a “My Settings” folder in a location that you have write permissions 
to, such as the My Documents folder. Name the file and click Save.

Creating a 
New Settings 
Group

To create a new settings group. Choose the Manage Settings command from the Settings 
menu, which will launch the Settings Manager.

The available settings are listed in a tree in the left hand settings library window. By default 
DataTrax2 will try to load the Settings folder in the DataTrax2 folder. If you have created your 
own settings, you can add your settings folder to this settings library by clicking on the Add 
Folder to Library button and navigating to the desired folder location. Each setting can have a 
a difficulty level and an aim associated with it. The difficulty level for each setting is visible in 
the Difficulty column. If you select a settings file, the aim of the setting is visible under the 
settings library window. 

To create a new group, click the New button in the Current Settings Group area. This will 
remove the current group and clear the Group Display window. 

To load an existing group, click on the Load button in the Current Settings Group area. This 
will remove the current group and replace it with the loaded group in the Group Display window. 
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Categories Settings files can be organized into categories within a group. To create a new category in the 
settings group, click on the Add Category button and name the category. You can add settings 
files from the list of available settings to any category or root category. Settings added to the 
root category are listed in the Settings menu below the other categories. 

Helper Files Helper files are documents with experimental instructions, diagrams and illustrations that can 
be linked to settings files and displayed on the computer screen when a settings file is 
selected. On the DataTrax2 installation CD, WPI provides a laboratory manual and a settings 
group for each of its kits. In the installation process, a .pdf copy of each individual lab exper-
iment in a manual is linked to the corresponding settings file in the settings group for that 
manual. When the user selects a settings file to do a particular experiment, a .pdf copy of the 
linked helper file (the experimental write-up) opens in Acrobat Reader. The user now has a set 
of instructions, on the computer screen, to follow as they do the experiment.

Users can associate their own helper files to their own settings files. Although, WPI has 
chosen to attach .pdf documents to its setting files, any file (HTML, Word Perfect, MS Word, 
etc.) can be linked to a settings file. To associate helper files with any settings file, place your 
helper files in the same location as the settings file and give the helper file the same name as 
the settings file name, but with the appropriate extension. For example, to associate a pdf, an 
html and a jpg file with the Tutorial.iwxset settings file, copy the pdf, html and jpg file to the 
same folder as the Tutorial.iwxset settings file. Name the pdf file Tutorial.pdf, the html file as 
Tutorial.html, and the jpg file as Tutorial.jpg. Now when the Tutorial settings file is chosen in 
DataTrax2, the Tutorial.pdf, the Tutorial.html and the Tutorial.jpg files will be opened. 
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Chapter 8: Export

Printing
Once you have recorded and analyzed your data, you’ll probably want to create a report or 

other presentation. This can be done in a variety of ways, the easiest of which is to simply print 
the recorded data. The DataTrax2 software uses a WYSIWYG (What You See Is What You Get) 
printing scheme. That is, the Print command will print the forward window exactly as it appears. 
This is particularly important for the Journal and the Analysis window as they require that the 
correct segments of data be displayed exactly as you want to print them before they can be 
printed. 

Cutting, Copying and Pasting
DataTrax2 supports cutting and copying from all windows. Copying is done from any window 

using the Copy command in the Edit menu. Within the DataTrax2 program, pasting is supported 
only in the Journal. To paste into the Journal, first copy data from either the Main or Analysis 
windows. Open the Journal, go to the Edit menu and select Paste.

Saving and Saving As
Once recorded, the DataTrax2 program can save data in its own binary format using the Save 

or Save As command found in the File menu. These commands work the same as they do in 
every other program written for Windows or Apple computers. Selecting Save As will create a 
copy of the file on the disk with a new name. DataTrax2 can save three types of documents:

1 The data file with the.iwxdata extension (WPI Document)

2 The Journal as an html file

3 The settings with the extension .iwxset (WPI Settings)

Journal
The Journal is actually very similar to WordPad. It can be exported to the disk in .htm format 

allowing it to be opened and edited in any program that supports that format. A formatted and 
edited .htm file may then be printed in whatever program you are using to read it.

In addition to images, calculated values from the Analysis window or the ScopeView window 
can be moved to the Journal by calling the Add Data to Journal command in the Tools menu. 
Prior to moving calculated values, it is recommended that the title line from the Analysis 
window be moved by using the Add Titles to Journal command in the Tools menu. Titles and 
data are tab delimited so they can be easily formatted in any word processing program.

By moving pictures and calculated values to the Journal and adding typed comments from the 
keyboard, an entire lab report can be created without ever leaving the DataTrax2 program.
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 Figure 8-1: Text and image as displayed in the Journal window.

Exporting Data
Data can be exported from DataTrax2 as either numbers or pictures from any window. To 

export data, select Export from the File menu and choose the file’s format, location and name in 
the dialog window.

Exporting 
Pictures

The current display can be exported as a picture in bitmap (.bmp) format or in a portable 
network graphics (.png) format. Portable Network Graphics is a high resolution format for 
images. 

Exporting 
Numerical 
Data

If data is exported from the Main window, the complete data file is exported in either Matlab or 
DADiSP formats.
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If data is exported from the Analysis or ScopeView windows, then only the data displayed in 
the window is exported.

Data from the Analysis or ScopeView windows can be saved in Text (.txt), Matlab (.mat), 
Axon Text Format (.atf), or DADiSP (.dat) format.
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